DH250 SERIES
Digital Video Surveillance Recorder
8/16 H.264 / CMS-DH PC/Mac 3G Mobile 480/480 D1

DH230 SERIES
Digital Video Surveillance Recorder
4/8/16 H.264 / CMS-DH PC/Mac 3G Mobile 480/480

www.digimerge.com
Copyright © 2011 Digimerge Technologies Inc.
Thank you for purchasing this product. Digimerge is committed to providing our customers with a high quality, reliable security solution. This manual refers to the following models:

- DH230 Series (4/8/16 channel)
- DH250 Series (8/16 channel)

For more information on this product, firmware updates, and accessory products, please visit us at:

www.digimerge.com
Important Safeguards

In addition to the careful attention devoted to quality standards in the manufacturing process of your video product, safety is a major factor in the design of every instrument. However, safety is your responsibility too. This sheet lists important information that will help to assure your enjoyment and proper use of the video product and accessory equipment. Please read them carefully before operating and using your video product.

Installation

1. **Read and Follow Instructions** - All the safety and operating instructions should be read before the video product is operated. Follow all operating instructions.

2. **Retain Instructions** - The safety and operating instructions should be retained for future reference.

3. **Heed Warnings** - Comply with all warnings on the video product and in the operating instructions.

4. **Polarization** - Do not defeat the safety purpose of the polarized or grounding-type plug.
   - A polarized plug has two blades with one wider than the other.
   - A grounding type plug has two blades and a third grounding prong.
   - The wide blade or the third prong are provided for your safety.
   - If the provided plug does not fit into your outlet, consult an electrician for replacement of the obsolete outlet.

5. **Power Sources** - This video product should be operated only from the type of power source indicated on the marking label. If you are not sure of the type of power supply to your location, consult your video dealer or local power company. For video products intended to operate from battery power, or other sources, refer to the operating instructions.

6. **Overloading** - Do not overload wall outlets of extension cords as this can result in the risk of fire or electric shock. Overloaded AC outlets, extension cords, frayed power cords, damaged or cracked wire insulation, and broken plugs are dangerous. They may result in a shock or fire hazard. Periodically examine the cord, and if its appearance indicates damage or deteriorated insulation, have it replaced by your service technician.

7. **Power Cord Protection** - Power supply cords should be routed so that they are not likely to be walked on or pinched by items placed upon or against them, paying particular attention to cords at plugs, convenience receptacles, and the point where they exit from the video product.

8. **Ventilation** - Slots and openings in the case are provided for ventilation to ensure reliable operation of the video product and to protect it from overheating. These openings must not be blocked or covered. The openings should never be blocked by placing the video equipment on a bed, sofa, rug, or other similar surface. This video product should never be placed near or over a radiator or heat register. This video product should not be placed in a built-in installation such as a bookcase or rack unless proper ventilation is provided or the video product manufacturer’s instructions have been followed.

9. **Attachments** - Do not use attachments unless recommended by the video product manufacturer as they may cause a hazard.

10. **Camera Extension Cables** - Check the rating of your extension cable(s) to verify compliance with your local authority regulations prior to installation.

11. **Water and Moisture** - Do not use this video product near water. For example, near a bath tub, wash bowl, kitchen sink or laundry tub, in a wet basement, near a swimming pool and the like. **Caution**: Maintain electrical safety. Powerline operated equipment or accessories connected to this unit should bear the UL listing mark of CSA certification mark on the accessory itself and should not be modified so as to defeat the safety features. This will help avoid any potential hazard from electrical shock or fire. If in doubt, contact qualified service personnel.

12. **Accessories** - Do not place this video equipment on an unstable cart, stand, tripod, or table. The video equipment may fall, causing serious damage to the video product. Use this video product only with a cart, stand, tripod, bracket, or table recommended by the manufacturer or sold with the video product. Any mounting of the product should follow the manufacturer’s instructions and use a mounting accessory recommended by the manufacturer.
Service

13. **Servicing** - Do not attempt to service this video equipment yourself as opening or removing covers may expose you to dangerous voltage or other hazards. Refer all servicing to qualified service personnel.

14. **Conditions Requiring Service** - Unplug this video product from the wall outlet and refer servicing to qualified service personnel under the following conditions:
   - When the power supply cord or plug is damaged.
   - If liquid has been spilled or objects have fallen into the video product.
   - If the video product has been exposed to rain or water.
   - If the video product does not operate normally by following the operating instructions. Adjust only those controls that are covered by the operating instructions. Improper adjustment of other controls may result in damage and will often require extensive work by a qualified technician to restore the video product to its normal operation.
   - If the video product has been dropped or the cabinet has been damaged.
   - When the video product exhibits a distinct change in performance. This indicates a need for service.

15. **Replacement Parts** - When replacement parts are required, have the service technician verify that the replacements used have the same safety characteristics as the original parts. Use of replacements specified by the video product manufacturer can prevent fire, electric shock or other hazards.

16. **Safety Check** - Upon completion of any service or repairs to this video product, ask the service technician to perform safety checks recommended by the manufacturer to determine that the video product is in safe operating condition.

17. **Wall or Ceiling Mounting** - The cameras provided with this system should be mounted to a wall or ceiling only as instructed in this guide, using the provided mounting brackets.

18. **Heat** - The product should be situated away from heat sources such as radiators, heat registers, stoves, or other products (including amplifiers) that produce heat.

Use

19. **Cleaning** - Unplug the video product from the wall outlet before cleaning. Do not use liquid cleaners or aerosol cleaners. Use a damp cloth for cleaning.

20. **Product and Cart Combination** - Video and cart combination should be moved with care. Quick stops, excessive force, and uneven surfaces may cause the video product and cart combination to overturn.

21. **Object and Liquid Entry** - Never push objects for any kind into this video product through openings as they may touch dangerous voltage points or “short-out” parts that could result in a fire or electric shock. Never spill liquid of any kind on the video product.

22. **Lightning** - For added protection for this video product during a lightning storm, or when it is left unattended and unused for long periods of time, unplug it from the wall outlet and disconnect the antenna or cable system. This will prevent damage to the video product due to lightning and power line surges.
General Precautions

1. All warnings and instructions in this manual should be followed.
2. Remove the plug from the outlet before cleaning. Do not use liquid aerosol detergents. Use a water dampened cloth for cleaning.
3. Do not use this unit in humid or wet places.
4. Keep enough space around the unit for ventilation. Slots and openings in the storage cabinet should not be blocked.
5. During lightning storms, or when the unit is not used for a long time, disconnect the power supply, antenna, and cables to protect the unit from electrical surge.

FCC CLASS A NOTICE

NOTE

This equipment has been tested and found to comply with the limits for a Class A digital device pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the manufacturer’s instruction manual, may cause harmful interference with radio communications. Operation of this equipment in a residential area is likely to cause harmful interference, in which case you will be required to correct the interference at your own expense.

This equipment has been certified and found to comply with the limits regulated by FCC, EMC, and LVD. Therefore, it is designated to provide reasonable protection against interference and will not cause interference with other appliance usage.

However, it is imperative that the user follows the guidelines in this manual to avoid improper usage which may result in damage to the unit, electrical shock and fire hazard injury.

In order to improve the feature functions and quality of this product, the specifications are subject to change without notice from time to time.
DH230 Features

- Real Time Recording: 120fps @ D1, 240fps @ 2CIF, 480fps @ CIF
- Event Log Search, Preview Search, Motion Area
- Search, Go To Search
- SMART network transfer
- HDMI, VGA, Spot, Looping Outputs
- Disk Mirroring Function
- Advanced user configuration
- Security Certified Hard Disk with up to 6TB of storage
- Hardware watch-dog/power Failure recovery: auto-reboot while maintaining settings and data
- DVR temperature alert, auto power-off
- S.M.A.R.T. HDD
- PC/Mac Compatible
- 3G Smartphone (BlackBerry, iPhone, Android)
- Tablet Compatible [iPad, Android, Windows]
- CMS-DH application supports up to 300 DVRs,
  - 64 ch/screen, E-Map, full control, 8 screen display

*Please visit www.digimerge.com/Touch for information, firmware, and compatibility updates for mobile viewing*
DH250 Features

- Real Time Recording [480fps @D1, 720 x480]
- Event log Search, Preview Search, Motion Area Search, Go To Search
- HDMI, VGA, Spot, Looping Outputs
- Disk Mirroring Function
- Advanced User Configuration
- Security certified hard disk with up to 8TB internal storage
- Hardware Watch-Dog/Power Failure Recovery: Auto
- Reboot while Maintaining Previous Settings & Data
- Alarm Notification (MAX 5 users): e-mail alert
- DVR Temperature alert: Auto Power-Off
- S.M.A.R.T HDD
- PC/Mac Compatible
- 3G Smartphone (BlackBerry, iPhone, Android)
- Tablet Compatible (iPad, Android, Windows)
- CMS-DH application supports up to 300 DVRs, 64 ch/ screen, E-Map, full control, 8 screen display

*Please visit www.digimerge.com for information, firmware, and compatibility updates for mobile viewing
# TABLE OF CONTENTS

**Getting Started** .................................................................................. 1

**Basic Setup** ...................................................................................... 2

1. Connect the cameras .......................................................................... 2
2. Connect a monitor ............................................................................... 2
3. Connect the mouse ............................................................................ 2
4. Connect the Ethernet cable ............................................................... 2
5. Connect the power cable .................................................................... 2

**DH230: Front Panel** ........................................................................ 3

**DH230: Rear Panel** .......................................................................... 5

**DH250: Front panel** ......................................................................... 6

**DH250: Rear Panel** .......................................................................... 8

**Remote Control** ............................................................................... 9

Mouse Control ....................................................................................... 11
Mouse Tips .............................................................................................. 11
Touch Screen Control ............................................................................ 11
Touch Screen Tips .................................................................................. 11
Touch Panel Tips and Tricks (DH230 only) ........................................ 12

**Using the System** ........................................................................... 13

Password .................................................................................................. 13
On-Screen Display ................................................................................ 14
Using the Virtual Remote ..................................................................... 16
  Playback ............................................................................................... 17
Using the Virtual Keyboard ................................................................... 17
Setting the Time ..................................................................................... 18
Multi-Screen Display ............................................................................. 19
  Repositioning Channels ..................................................................... 19

**Recording** ......................................................................................... 21

Continuous Recording .......................................................................... 21
Event Recording .................................................................................... 21
  Motion .................................................................................................. 22
  Alarm .................................................................................................... 22
  Video Loss ............................................................................................ 22
Schedule Recording .............................................................................. 23
Recording Audio .................................................................................... 23

**Playback** .......................................................................................... 24

**Search** ............................................................................................... 25

  Quick Search ....................................................................................... 26
Setting up Sequencing .................................................. 30
  Sequence mode & Shift mode ...................................... 30
  Event View .............................................................. 31
  Configuring the EVENT tab ...................................... 32
  Connecting a SPOT OUT / CAMERA OUT monitor [DH230/250] .................................................. 32
Setting up Motion Recording ........................................ 33
  Triggering secondary cameras in Motion recording .......... 36
  Triggering cameras to record during Video Loss ............ 37
Using the Main Menu .................................................... 38
  DISPLAY .................................................................. 39
    GENERAL ............................................................... 39
    SWITCH / EVENT ...................................................... 39
  CAMERA ................................................................ 40
  RECORD ................................................................ 41
    GENERAL ............................................................... 41
    MODE ................................................................. 41
    DAY ................................................................. 42
    DAY EVENT ......................................................... 42
    NIGHT ............................................................... 43
    NIGHT EVENT ...................................................... 44
  SCHEDULE .............................................................. 45
    CHART ................................................................ 45
    HOLIDAY ................................................................ 45
  DISK ................................................................ 47
    DISK MANAGER ....................................................... 47
    Recording Disk .................................................. 48
  NETWORK ............................................................... 49
    ETHERNET ........................................................... 49
    GENERAL ............................................................... 49
    EMAIL .................................................................. 50
    DDNS .................................................................. 52
  DEVICE ................................................................. 53
    GENERAL ............................................................... 53
    ALARM .............................................................. 53
    PTZ EVENT .......................................................... 54
  SYSTEM ................................................................. 56
    GENERAL ............................................................... 56
    TIME .................................................................. 56
    ACCOUNT ............................................................ 56
    UPDATE .............................................................. 57
    INFO .................................................................. 57
Backup ........................................................................ 58
Back up to a USB Device or CD/DVD Burner .............................................. 58
Back up to an FTP Server ................................................................. 59
Viewing Backup Video ................................................................. 60
Using MCD Player ...................................................................... 61

CMS-DH Central Management Software ........................................ 63
System Requirements ................................................................. 63
Prerequisites .................................................................................. 63
Installing CMS-DH ....................................................................... 64
Starting CMS-DH ......................................................................... 65
Adding a Virtual DVR ..................................................................... 70
Creating New Group Folders & Sub folders ..................................... 72
Configuring General System Settings ............................................ 73
Adding Users ................................................................................. 74
Recording Video to the hard drive ................................................ 75
Playing back recorded video ........................................................ 76
Remote Search .............................................................................. 77
  Video Playback Controls ............................................................. 78
Local Search .................................................................................. 78
  Saving Video Files ...................................................................... 79
  Converting video files to AVI ..................................................... 80
Schedule Recording ....................................................................... 81
Schedule Backup to Local Hard Drive ........................................... 81
Configure Backup to FTP Server .................................................. 83
Taking Screen Captures .................................................................. 84
Viewing File Download Status ..................................................... 85
Changing viewing modes ............................................................... 85
Sequencing ..................................................................................... 86
E-Map .............................................................................................. 87
  E-Map Setup .............................................................................. 88
  Viewing video on E-Map ............................................................ 89
  Configuring E-Map camera settings ........................................... 89
  Zooming into the E-Map ............................................................ 90
  Removing camera icon in the E-Map .......................................... 90
Adding Multiple E-Maps ............................................................... 90
Viewing DVR Health ....................................................................... 91
Closing windows .......................................................................... 91
Locking Windows .......................................................................... 91
DVR Log ......................................................................................... 92
  Setting PTZ Pre-Sets ................................................................ 94
Upgrading the firmware remotely .................................................. 96
Configuring Post Event Action Tab ............................................... 97
  Setting up Post Event Actions on a NO/NC Device ..................... 97
Configuring Alarm Output ........................................................... 98
  Setting message pop-up notifications ...................................... 99
Installing the BDVRViewer App on your Blackberry ........................................ 130
Prerequisites ........................................................................................................... 130
Step 1 of 4: Download the BDVRViewer Application ........................................... 130
Step 2 of 4: Clear your browser cache .................................................................... 131
Step 3 of 4: Enable APN (Access Point Name) ....................................................... 132
Step 4 of 4: Log in to BDVRViewer ....................................................................... 133
Viewing Tips ............................................................................................................ 133
Appendix A: System Specifications ................................................................. 134
   DH230 Specs ........................................................................................................ 134
   DH230 Specs (cont’d.) ......................................................................................... 135
   DH250 Specs ....................................................................................................... 136
   DH250 Specs (cont’d.) ......................................................................................... 137
Appendix B: Setting up Remote Viewing ......................................................... 138
   What Do I Need? ................................................................................................ 138
   How Do I Find My IP and MAC addresses? .................................................... 139
      Finding Your External IP Address ................................................................ 139
   How Do I Enable Port Forwarding? .................................................................. 140
Appendix C: Digimerge Auto Port Forward Wizard ........................................ 141
   Installation ........................................................................................................... 141
      Obtaining Your Router Model Number and Version ..................................... 142
      Example ........................................................................................................... 142
   Configuration ....................................................................................................... 143
      Initial Startup: Select language ...................................................................... 143
      Step 1: Populate the router database ............................................................. 143
      Step 2: Enter your router settings .................................................................. 144
      Step 3: Update the router settings .................................................................. 145
      Step 4: Test your connection ....................................................................... 145
      Configuring multiple routers ......................................................................... 145
      Scenario A: Router/Modem combination + Router ....................................... 146
      Scenario B: Multiple Routers ....................................................................... 146
      Example ........................................................................................................... 147
Appendix D: Setting Up DDNS Service ............................................................ 148
   How Do I Enable DDNS On My System? ........................................................... 150
Appendix E: Setting Up Mobile Access .............................................................. 151
   Before You Begin ............................................................................................... 151
   Registering your DVR for Mobile Access .......................................................... 151
      Viewing Video from your Mobile Device ......................................................... 154
Appendix F: Connecting PTZ Cameras ............................................................. 155
   Using a PTZ Camera .......................................................................................... 156
   Setting Pre-Set and Tour ................................................................................... 158
Appendix G: Connecting Additional External Monitors .................................. 160
   75 OHM Switch [DH230 16-channel models only / DH250] ............................ 161
Appendix H: Connecting Motion / Alarm Devices .......................................... 162
Appendix I: Full Connectivity Diagram ............................................................. 163
Appendix J: Replacing the Hard Drive ................................. 165
  DH230: Removing the Hard Drive ........................................ 165
  DH230: Replacing the Hard Drive ........................................ 167
    DH230: Installing 2 hard drives ...................................... 168
  DH250: Removing the Hard Drive ........................................ 171
  DH250: Replacing the Hard Drive ........................................ 173
    DH250: Installing Multiple hard drives .............................. 174
  Formatting the Hard Drive ............................................. 175
Appendix K: Using Listen-in Audio ................................. 176
  Playing AVI Files ....................................................... 177
Appendix L: Remote Viewing using Internet Explorer .................... 178
Appendix M: DH230/250 Series Touch Screen Monitor Setup ............ 180
  Step 1 of 3: Connect the Cables ....................................... 180
  Step 2 of 3: Power on the Monitor ..................................... 181
  Step 3 of 3: Test the Touch Screen Functions .......................... 181
Troubleshooting ............................................. 182
  Troubleshooting (cont’d.) ............................................... 183
    Remote Connectivity Trouble Shooting .............................. 184
GETTING STARTED

The system comes with the following components:

DH230 DVR*
- POWER SUPPLY
- Camera Out-OCTOPUS CABLE
  [16-CHANNEL, DH230 SERIES ONLY]
- REMOTE CONTROL
- INSTRUCTION MANUAL, QUICKSTART GUIDE, & SOFTWARE CD

OR

DH250 DVR*
- POWER CORD
- 9-PIN TO RCA AUDIO CABLE
  (Note: 16-channel models include two 9-PIN to RCA Audio Cables)
- REMOTE CONTROL
- INSTRUCTION MANUAL, QUICKSTART GUIDE, & SOFTWARE CD

HARD DRIVE SIZE, NUMBER OF CHANNELS, AND CAMERA CONFIGURATION MAY VARY BY MODEL. PLEASE REFER TO YOUR PACKAGE FOR SPECIFIC CONTENT DETAILS.

CHECK YOUR PACKAGE TO CONFIRM THAT YOU HAVE RECEIVED THE COMPLETE SYSTEM, INCLUDING ALL COMPONENTS SHOWN ABOVE.
BASIC SETUP

1. Connect the cameras
   a. Connect BNC cameras to the BNC ports on the rear panel.

2. Connect a monitor
   If you are using a touch screen monitor (not included), connect a USB cable (not included) from a USB port on the front or rear panel of the system to the monitor.
   a. Connect a VGA cable (not included) from the **VGA OUT** port on the rear panel to the VGA port on your monitor, **OR**
   b. Connect a HDMI cable (not included) from the **HDMI** port to the HDMI port on your monitor, **OR**
   c. Connect a BNC terminated cable from one of the **VIDEO OUT** ports to a TV or CCTV monitor.
   d. Power on the monitor.

3. Connect the mouse
   a. Connect the mouse to the USB mouse port on the front or rear panel.

4. Connect the Ethernet cable
   a. Connect an Ethernet cable to the **LAN** port (DH230) / **LAN1** or **LAN 2** port (DH250) on the rear panel of the system; connect the other end of the Ethernet cable to an empty LAN port on your router or switch (not included).

   **NOTE: DH250 models:** Connect an ethernet cable to either **LAN1** or **LAN2**.

5. Connect the power cable
   a. **DH230:** Connect the power supply to the **DC12V** port on the rear panel of the system. **DH250:** Connect the power cord to the **AC IN** port in system’s rear panel. Connect the power cable to an outlet, power strip, or surge protector.
   b. Press the **POWER** button on the front panel.
1. **Indicators:**
   - **HDD:** Flickers green to indicate hard drive activity.
   - **REC:** Glows red to indicate system is recording.
   - **Backup:** Opens the backup menu.
   - **Search:** Opens the time-search menu.
   - **Display:** Change split-screen views.
   - **Cancel:** Press to exit from menus. In the main viewing window, press to toggle the on-screen display on/off (i.e. system time, recording indicators).
   - **Enter:** Press to confirm a selection within menus.

2. **Navigation cursor:**
   - Use the direction cursors [← → ↑ ↓] to navigate the system menus.
   
   **During Playback:**
   - **■■:** Pause (Still Mode) / Play the video.
   - **◀◀:** Rewind video. During Still Mode, press the Rewind button to move images frame-by-frame in reverse.
   - **►►:** Fast forward video. During Still Mode, press the Fast forward button to move images frame-by-frame forward.
   - **○○:** Start/Stop recording (password required for stoppage)
   - **■■:** Stop playback.
DH230: Front Panel (cont’d.)

During live view:

- **MENU**: Press to open the Main Menu, and to confirm menu selections.
- **Log-In**: Press to open the Log-In window.
- **Log**: Press to display the system Log.
- **Enter**: Press to confirm menu options/selections/ enter sub-menu options.
- **Cancel**: During Playback and menu navigations, press to exit the menu. In Live view, press to toggle the OSD on/off.
- **Alarm**: Press to toggle the Alarm window (appears on the top of the screen). The alarm window displays any alarms that has triggered on the system.

3. **POWER**: Press to power the system ON/OFF (password required. Default password = 000000).

4. **Channel numbers**:
   - **1~10/0**: Use these buttons to enter numerical values within system menus, or to enter in the user passwords. During Live view, press buttons 1~10/0 to view channels 1~10 in single channel view. The **10/0** button has a numerical value of 0.
   - **+10**: Press the **+10** button and a channel number to access channels 11 or greater. For example, press **+10** and **1** to access channel 11, press **+10** and **5** to access channel 15 etc.

- **+** **-**: Increase/decrease values within system menus.

5. **IR receiver**: IR receiver for the remote control. Keep the IR receiver clear from obstructions. If your remote does not respond to the DVR, ensure the IR receiver is not blocked by objects.

6. **USB Port**: Connect a USB flash drive, mouse, HDD, or optical drive for critical data backup; connect a USB flash drive for firmware upgrades.
1. **CAMERA OUT (16 channel only)**: Port for octopus cable (16-channel models only). Connect up to 16 additional Loop Out monitors.

2. **75 Ohm (16-channel only)**: Controls the DVR’s impedance when using loop-out monitors. This prevents the colors connected to loop-out monitors from being "washed out”.

3. **CAMERA IN**: Camera input ports for BNC cameras

4. **DC 12V**: Port for 12V DC 5A (4-channel) / DC 6A (8/16 channel) power supply (included).

5. **ALARM IN**: Alarm block to connect external alarm or motion devices (not included).
   - **RS422**: Connection block for an RS422 PTZ camera (not included).

6. **LAN**: Connect an Ethernet cable to connect the system to a router or switch (not included).
   - **USB port**: connect a USB mouse, USB memory key, or external hard drive.

7. **VGA**: VGA port to connect the system to a VGA monitor.

8. **HDMI**: HDMI port to connect the system to a HDMI TV/monitor.

   **NOTE**: The HDMI port outputs to a maximum resolution of 1920 x 1080i. However, the recording resolution is a maximum of 720x480 (D1 resolution). This means that when viewing pre-recorded video, the image will not display in true HD form.

9. **AUDIO IN** (Top port): One 3.5” RCA port (mono) for recording audio from an audio capable camera (not included).
   - **AUDIO OUT** (Bottom port): One 3.5” RCA port (mono) for audio output.

10. **VIDEO OUT** (Top Port): Video output (BNC) to connect the system to a secondary monitor or DVR.
   - **SPOT OUT**: Video output to connect the system to an external monitor (not included). Spot Out mode displays channels switching in an automatic sequence.
DH250: FRONT PANEL

1. **Power Button**: Press to power on/off the system [Password required].

2. **Number Keys**: Press to view channel in full screen mode. The 0/10 button acts as channel 10 when pressed during live view. Within menus, press the number keys to enter numbers. The 0/10 acts as “0” when pressed within menus.

3. **Lock, Backup, and Search**:
   - **LOCK**: Press to lock the system.
   - **BACKUP**: Press to open the back up menu.
   - **EXT.SEARCH**: Press to open the External Search menu. The External Search menu searches for video on external storage devices (i.e. external USB hard drive).
   - **USB**: Connect an external USB device (i.e. USB mouse or external USB hard drive).

4. **DVD-RW**: Insert a blank CD-R / DVD-R media to back up video files.

5. **Navigation buttons**:
   - **← ▲ ▼ →**: Press to navigate the system menu.
   - **ENTER**: Press to confirm a selection or save changes.
   - **CANCEL**: Press to cancel a selection.
   - **MENU**: Press to open the main menu.
   - **- / +**: Press the - / + buttons to increase or decrease values within menus.

6. **Playback & Display buttons**:
   - **STOP**: Press to stop all recording (password required).
   - **REC**: Press to resume recording after the system stops recording.
   - **PLAY**: During playback, press to begin playback.
   - **STILL**: Press to pause video.
   - **DISPLAY**: Press to change split-screen views.
   - **ZOOM**: During live view, press to open the zoom menu.
   - **P/T/Z FOCUS**: In single-channel view, press to open the PTZ menu.
• **LOG IN / LOG OUT**: Press to log in / log out of the system (password required)
• **TIME SEARCH**: Opens the time search menu.
• **LOG**: Opens the system log menu.
• **SHUTTLE HOLD**: During the fast forward, or reverse playback mode using the Jog Ring/Shuttle wheel, press the SHUTTLE HOLD button to lock the playback speed.

7. **Jog Ring / Shuttle Wheel**: Use the Jog Ring/Shuttle Wheel to fast forward or rewind video during playback.

**Using the Shuttle Wheel**
During playback, twist the shuttle wheel clockwise to increase the playback speed. The further you turn the shuttle wheel, the faster the system fast forwards. Release the shuttle wheel to pause playback. The same applies when twisting the shuttle wheel counter-clockwise, except the video plays backwards (reverse playback).

**Using the Jog Ring**
The Jog Ring allows you to play video frame-by-frame (advance frame) during playback.
To use the Jog Ring, pause the video, then turn the shuttle wheel forward or backward to play video frame-by-frame.
1. **CAMERA IN**: Camera input ports for BNC cameras.
2. **CAMERA OUT**: Connect up to 16 additional Loop Out monitors.
3. **AC IN**: Connect a power cable to the AC IN port. Connect the other end of the cable to a power outlet.
4. **75 OHMS**: Controls the DVR’s impedance when using loop-out monitors. This prevents the colors connected to loop-out monitors from being “washed out”.
5. **AUDIO IN**: Connect an audio-in octopus cable (9-pin to RCA) to connect up to 16 audio-enabled cameras or powered mic (not included).
6. **AUDIO OUT**: Connect one 3.5” RCA port (mono) for audio output.
7. **VIDEO OUT**: Video output [BNC] to connect the system to a secondary monitor or DVR.
8. **SPOT OUT**: Video output to connect the system to up to 3 external monitors (not included). Spot Out mode displays channels switching in an automatic sequence.
9. **VGA OUT**: VGA port to connect the system to a VGA monitor.
10. **HDMI**: HDMI port to connect the system to a HDMI TV/monitor.

   **NOTE**: The HDMI port outputs to a maximum resolution of 1920 x 1080i. However, the recording resolution is a maximum of 720x480 (D1 resolution). This means that when viewing pre-recorded video, the image will not display in true HD form.

11. **eSATA**: Connect up to two eSata external hard drives for data backup.
12. **USB**: Connect an external USB device (i.e. USB mouse or external USB hard drive).
13. **LAN1 & LAN2**: Connect an ethernet cable to connect the system to a router or switch (not included). Connect an ethernet cable to either LAN1 or LAN2.
15. **ALARM IN / RELAY**: Connect alarm sensors/PTZ cameras to the ALARM IN / RELAY block.
16. **Exhaust Fan**: Keep the exhaust vent clear at all times.
REMOTE CONTROL

1. **DVR ID:** Pairs the DVR with the remote (optional). For details, see “GENERAL” on page 56.
2. **POWER:** Press to power the system ON/OFF (password required).
3. **System configuration buttons:**
   - **TIME SEARCH:** Press to open the Time Search menu.
   - **EXTERNAL-SEARCH:** Press to open the External Search menu. The External Search menu allows you to browse for content on an external hard drive connected to the DVR.
   - **LOG:** Press to open the system log.
   - **SPOT OUT:** Press to select SPOT OUT output.
   - **INFO:** Press to view vital system information.
   - **BACKUP:** Press to open the Backup Menu.
   - **DISPLAY ( ):** Press to switch between single channel full-screen, quad, and split-screen displays.
   - **ZOOM:** Press to open the zoom field (live view, single channel only). Press ENTER to zoom in.
   - **P/T/Z:** Press to open the PTZ menu.
4. **Navigation/Menu:**
   - **↑:** Press to move cursor up
   - **↓:** Press to move cursor down
   - **←:** Press to move cursor left
   - **→:** Press to move cursor right
   - **MENU:** Press to open the Main Menu, and to confirm menu selections.
   - **ENTER ( ):** Press to confirm menu options/selections/enter sub-menu options.
   - **CANCEL/OSD:** Press to close menu windows; press to show/hide the on-screen display (OSD); press to clear channel indicators (loss, alarm, etc.).
   - **+/ -:** Press to increase/decrease menu options.

You can use the channel buttons on the remote control to enter numbers, letters, and other characters.
5. **Playback controls:**
- ■: Press to stop playback
- ◯: Press to begin playback; press to switch between forward and reverse playback
- ▸: Press repeatedly to increase forward playback speed
- ●: Press to start/stop manual recording.
- SCH/LOGIN: Opens the Login window to log in or out of the system.
- ▶ and ▶: During playback, press to pause; press repeatedly for frame-by-frame playback

6. **Channel buttons**: Press to view channels 1–16 individually in full-screen; press to input passwords; when entering camera titles, press for alpha-numeric characters. Note that the 0/10 button means “0” when entering passwords, and “10” when accessing channel 10 [16-channel models only].

You can use the channel buttons on the remote control to enter numbers, letters, and other characters.
Mouse Control

The mouse is the primary control device for the system. To connect a USB mouse:

1. **Left-Button**: While in a split-screen display mode, double-click an individual channel to view it in full-screen; double-click again to return to the split-screen display mode. While navigating menus, click to select a menu option; double-click to open the next menu.
2. **Right-Button**: Right-click anywhere on the screen to open the Virtual Remote; double-click anywhere on the screen to return to the previous menu.
3. **Scroll-Wheel**: Move the scroll wheel up or down to increase/decrease the value of a selected menu option.

Mouse Tips

When using the mouse, the ENTER and EXIT buttons appear in the top-right corner of every menu window. When you change system settings and configurations, click ↓ [ENTER] to save your changes.

Touch Screen Control

A touch screen monitor (not included) can be used as a substitute for mouse control. Touch screen monitors must be Windows 7® Touch compatible to work with the system.

**To connect a touch screen monitor:**
1. Connect a USB cable (not included) from a USB port on the front or rear panel of the system to the monitor.
2. Connect a VGA cable (not included) from the VGA OUT port on the rear panel to the monitor, OR
   - Connect an HDMI cable (not included) from the HDMI port on the rear panel to the monitor.
3. Power on the monitor, and then power on the system.

**To control the system using a touch screen:**

- **While in viewing or playback mode**, press and hold anywhere on the screen to access the Virtual Remote. For details, see “Using the Virtual Remote” on page 16. Tap outside the Virtual Remote to exit.
- **While in a split-screen display mode**, double-tap an individual channel to view it in full-screen. Double-tap again to return to split-screen display mode.
- **While navigating menus**, tap to select a menu option.

Touch Screen Tips

When using a touch screen, the ENTER and EXIT buttons appear in the top-right corner of every menu window. When you change system settings and configurations, tap ↓ [ENTER] to save your changes.

You can reposition camera channels using a touchscreen. For details, see “Repositioning Channels” on page 19.
Touch Panel Tips and Tricks (DH230 only)

If using the Touch panel, you will often use the following buttons when controlling the system:

- \[ \text{\(\text{}\)} \text{; Menus: move cursor up; Playback: pause playback; Live viewing: show/hide OSD/ Alarm OSD;} \]
- \[ \text{\(\text{}\)} \text{; Menus: move cursor down; Playback: stop playback; Live viewing: open Log menu} \]
- \[ \text{/} \text{; Menus: move cursor left; Playback: increase reverse playback speed; Live viewing: start/stop recording} \]
- \[ \text{/} \text{; Menus: move cursor right; Playback: increase forward playback speed; Live viewing: open the log in window.} \]

Press the MENU button to open the main menu AND close windows/exit. Press the MENU button to confirm menu selections.

**NOTE:** This manual refers to the CANCEL/ESC button on the remote control for closing/exiting menu windows. If using the front panel, press MENU/ESC to close/exit menu windows.

- Press the \[ \text{} \] button to increase values for selected menu options
- Press the \[ \text{} \] button to decrease values for selected menu options
- Press the \[ \text{} \] button to confirm a selection.
USING THE SYSTEM

The default system password is 000000

To power the system ON:
1. Connect the power cable to the port on the rear panel.
2. Press the POWER button on the front panel or remote control.

To power the system OFF:
1. Press the Stop button (■) to halt system recording.
2. Enter your system password.
3. Press the POWER button on the front panel or remote control.
4. Enter your system password to shut down the system.

Password

The default system password is 000000. You can configure the system password through the Main Menu>System>ACCOUNTS. For complete information on changing your password and managing users on the system, see "ACCOUNT" on page 56.
On-Screen Display
The system shows the following for all display views:

1. **Recording Indicator**: “REC” indicates that continuous recording is enabled on at least one channel. 
   **NOTE**: If REC does not appear on the onscreen display the system is **NOT RECORDING**.

2. **Display**: Show live video and playback in single channel full-screen, quad, and split-screen configurations.

3. **Recording Status & Channel indicator**: The number indicates the channel number. The colors have different meanings:
   - Black - No recording in progress.
   - Yellow - Continuous recording in progress.
   - Red - Event (Motion/Alarm) Recording in progress.

4. **Channel Title**: You can customize the channel with a unique name for each channel. See “CAMERA” on page 40.

5. **Camera Status**: Will display a green Motion icon, purple Loss icon, or a yellow Alarm icon.
6. Status Indicators

- **CD/DVD Drive Indicator**: Indicates that a CD/DVD writer is connected to the DVR. The indicator glows blue when CD/DVD burning is in progress.
- **USB Indicator (Front panel)**: Glows blue when a USB device is connected to the front USB port to perform a system backup.
- **USB Indicator (Rear panel)**: Glows blue when a USB device is connected to the rear USB port to perform a system backup.
- **User Status**: Indicates what type of user is currently logged in.
  - : The system administrator is logged in.
  - : A user is logged in.
  - : The system is locked.
- **Audio Indicator**: During video playback, if there is audio present, the Audio Indicator glows blue.
- **Connected Users**: Shows the number of users who are connected to the system via the network (i.e., through the web browser or smartphone).

7. **Date/Time**: Shows the date (mm/dd/yyyy), day of the week, and time (24-hour clock).

![Date/Time Display](image)

8. **HDD/Record days**: Shows the remaining hard drive space and the number of recording days before the hard drive is full. Note that if the hard drive capacity is less than 5GB, the icon appears to indicate overwrite is enabled. When overwrite is enabled, the first video that is recorded will be deleted (first in first out).

![HDD/Record Days Display](image)

9. **Spot Monitor Indicator**: Displays the monitor that is currently in Spot Out mode.
Using the Virtual Remote

Right-click anywhere on the screen to open the Virtual Remote. The Virtual Remote gives you quick access to many of the system’s features using only a USB mouse (included).

1. **Quick Function Keys:**
   - ⌘: Time Search
   - ⌘: Window Positioning
   - Log
   - Spot Out
   - ⌘: System Info
   - ⌘: Backup
   - ⌘: Display Mode
   - Zoom
   - PTZ: Opens the PTZ menu.
   - ⌘: F1 button.
   - ⌘: F3 button.
   - ⌘: External Search

2. **Navigation/Menu:**
   - ▲: Move cursor up
   - ▼: Move cursor down
   - ◀: Move cursor left
   - ◁: Move cursor right
   - MENU: Press to open the Main Menu, and to confirm menu selections.
   - →: Press to confirm menu options/selections/ enter sub-menu options.
   - ESC: Close menu windows; press to show/hide the onscreen display (OSD); press to clear channel indicators (loss, alarm, etc.)
   - +: Increase values in menu options.
   - -: Decrease menu options in menu options

3. **Playback controls:**
   - ■: Stop playback / stop system recording
   - ◀ ◁: Increase reverse playback speed 1X, 2X, 4X, 8X, and 16X
   - ◁: Start playback; press to switch between forward and reverse playback
   - ◁+: Increase forward playback speed 1X, 2X, 4X, 8X, and 16X
   - ◁: Start manual recording (if scheduled recording is not active)
   - ⌘: Log in/ Log out of the system (password required)
   - ◀ ◁: During playback, click to pause; click repeatedly for frame-by-frame playback; during live viewing, click to open the PTZ menu
   - ◀ ◁: During playback, click to pause; click repeatedly for frame-by-frame playback; during live viewing, click to SPOT OUT

4. **Channel buttons:** Click to view channels 1~8 individually in full-screen; click to input passwords; when entering camera titles, click for alpha-numeric characters.

**NOTE:** The button labeled 0/10 means 0 when entering passwords, and 10 when entering channel 10 for the 16 channel model DVR.
**Playback**

During playback, you can right-click anywhere on the screen to open a condensed version of the Virtual Remote.

1. **Navigation/Menu:**
   - ▲: Move cursor up
   - ▼: Move cursor down
   - ◀: Move cursor left
   - ▶: Move cursor right
   - MENU: Opens system’s main menu.
   - ◄: Click to confirm menu options/selections
   - ESC: Click to close menu windows; click to show/hide the onscreen display (OSD); click to clear channel indicators (loss, alarm, etc.)
   - +: Increase values in menu options.
   - -: Decrease menu options in menu options

2. **Playback controls:**
   - ■: Stop playback
   - ◄: Increase reverse playback speed 1X, 2X, 4X, 8X, and 16X
   - ▶: Start playback; press to switch between forward and reverse playback
   - ▶: Increase forward playback speed 1X, 2X, 4X, 8X, and 16X

3. **Quick Function Keys:**
   - ◼: Click to open the Time Search menu
   - Log: Click to open the Log menu
   - ◀: During playback, click to pause; click repeatedly for frame-by-frame playback
   - ▶: During playback, click to pause; click repeatedly for frame-by-frame playback

**Using the Virtual Keyboard**

When configuring certain options, such as Camera Title, the Virtual Keyboard opens to make mouse input easier.
Setting the Time

It is highly recommended to set the time on the system prior to doing any recording.

All recording must be stopped on the system in order to set the time.

To set the date and time:
1. Stop recording on the system by pressing ■ on the front panel, or press the ■ button on the remote control and enter your 6-digit system password (by default, 000000).
   **NOTE:** If using the mouse, right-click and then click ■ on the Virtual Remote.
2. Press the MENU button to open the system menu. Select SYSTEM and press the ENTER button. The System menu opens.
3. Select the TIME tab.

   ![System Time Menu]

4. Select DATE and enter the date (yyyy/mm/dd).
5. Select TIME and enter the time (hh/mm/ss).
   **NOTE:** If using the mouse, use the Virtual Keyboard to enter the date and time.
6. Press the ENTER button to save your changes.
7. Press the Cancel button on the front panel, or press the ESC button on the virtual remote to exit to the Live viewing window.
8. Press press the ● button on the remote control to resume Continuous Recording.
   **NOTE:** If using the mouse, right-click and then click ● on the Virtual Remote.

**NOTE:** Ensure the REC symbol appears on the top-left corner. If you do not see the REC symbol, the DVR has stopped recording.
Multi-Screen Display

The system can display channels in full-screen single channel, quad, and multi split-screen displays.

Repositioning Channels

You can reposition the channels on the display screen. This can be very useful when monitoring a live location(s).

To reposition the display channels using a mouse:
1. Using the mouse, remote control, or front panel, place the main display screen in either a quad display, or in a multi split-screen configuration.
   **NOTE:** Repositioning will not work if the main display screen is in full-screen single channel.
2. Using the mouse, right-click anywhere on the screen to open the Virtual Remote.
3. From the Virtual Remote, click . The Blue Window cursor appears in the top-left channel (typically channel 1).
4. Reposition the channels through the following:
   - **Remote Control:** Press the button for the channel you wish to place in the location of the Blue Window cursor. For example, if the cursor is on channel 1, and you want to have channel 4 in its location, press the 4 button on the remote control. You can also press F2 on the remote to open the Blue Window cursor, then press the desired channel number that you wish to change to.
   - **Front Panel:** Press the button for the channel you wish to place in the location of the Blue Window cursor

5. Press the ▲▼◄► to change the location of the Blue Window cursor.
6. Press the **MENU** button to save your settings.
To reposition the display channels using a touch screen monitor:
1. Place the main display screen in either a quad display, or in a multi split-screen configuration.
   **NOTE:** Repositioning will not work if the main display screen is in full-screen single channel.
2. Press and hold inside the channel you would like to move. Drag your finger to the channel you wish to reassign it to and release.

   **NOTE:** If the Virtual Remote appears while doing this, you may ignore it. After repositioning the channel, tap anywhere outside the Virtual Remote to exit.
RECORDING

By default, the system is set to immediately record at startup from connected cameras. This is called continuous recording. It is highly recommended to keep continuous recording on at all times.

The system can perform Continuous Recording, Event Recording, and Schedule Recording. However, the system can only perform one type of recording at a given time.

Continuous Recording

By default, all camera channels are enabled with continuous recording. During Continuous Recording, the **REC icon** appears in the top left corner of the OSD.

Event Recording

The system includes three modes of event recording:

- **Motion**: The system only records when motion is detected by the affected camera
- **Alarm**: The system records when an alarm or sensor is triggered
- **Video Loss**: The system records when a camera is disconnected or suffers video loss. The system employs a pre-record function to capture video seconds before the video loss occurred

You can customize the recording parameters (video quality, frames-per-second) of Event Recording in the Record menu. See “RECORD” on page 41.
**Motion**

When motion is detected, the system will continue to record, but can apply unique recording parameters for each camera that you can set in the EVENT and DAY EVENT MENU [Main Menu → Record → Day or NIGHT (EVENT) → Day or NIGHT EVENT]. The camera enabled with Motion Detection will have a RED icon number on the OSD.

![Image](image.png)

**NOTE:** A black icon indicates that recording on a camera is disabled. For better security it is highly recommended to keep continuous recording for all cameras on at all times. Use caution when assigning motion detection to specific cameras.

When motion is detected by the camera, the motion icon will appear.

![Image](image.png)

**NOTE:** Press the CANCEL/ESC button on the remote control, front panel, or Virtual Remote to clear the motion icon.

**Alarm**

When an alarm is triggered, the system will continue to record, but can apply unique recording parameters that you can set in the EVENT and DAY EVENT menu [Main Menu → Record → Day or NIGHT EVENT]. A red channel icon appears when an alarm event occurs on the channel.

**NOTE:** Press the CANCEL/ESC button on the remote control, front panel, or Virtual Remote to clear the alarm icon.

**Video Loss**

If a camera is disconnected or is damaged, the video loss icon will appear for the affected channel. The channel number will turn BLACK. Once video has been restored, press the CANCEL/ESC button on the remote control, front panel, or Virtual Remote to clear the video loss icon.
Schedule Recording

Schedule Recording can be set manually or at startup. Schedule Recording features customizable recording parameters that you assign to each camera.

**ATTENTION:** Schedule Recording takes priority over all other recording modes.

To access the Schedule Recording tab:
1. Press the MENU button on the front panel, or virtual remote (right-click → **MENU**).
2. Click **RECORD**.
3. In the GENERAL tab, Under SCHEDULE USE, select **ON**.
4. Click the DAY, DAY EVENT tabs to configure scheduled recording.

For details on scheduled recording, see “RECORD” on page 41.

Recording Audio

The system can record one channel of audio. You must have an audio enabled camera or self-powered microphone connected to the system in order to use this function. For details on connected audio recording devices, see “Appendix K: Using Listen-in Audio” on page 176.
PLAYBACK

View recorded video on the system through playback mode.

To begin playback:
1. Select the number of channels you wish to playback (i.e single channel, or quad view etc.)
2. Press the Play button () on the remote control or press ▶ on the Virtual Remote. The system will play the last few minutes of the most recently recorded video.
3. Press the following buttons on the remote control to use playback functions:
   - : Press to switch between forward and reverse playback
   - ◀: Press to pause playback; press repeatedly for frame-by-frame reverse playback
   - ▶: Press to pause playback; press repeatedly for frame-by-frame forward playback
   - : Press to increase reverse playback speed 1X, 2X, 3X, 4X, 5X
   - : Press to increase forward playback speed 1X, 2X, 3X, 4X, 5X

To return to Live viewing:
- Press ■ to stop playback and return to live viewing
SEARCH

Search for recorded video data on the system using the Time Search menu.

**To open the Time Search menu:**

- Press the Search button (  ) on the front panel or remote control (  )

**To search for recorded video with Multi-channel playback:**

1. Beside the “Day” field, click on the date you wish to search for. Then scroll DOWN (or click + on the virtual remote) on the mouse to select the Hour. Select the desired hour. Scroll DOWN (or click + on the virtual remote) again to select the desired minute.

2. Click the Enter button on the remote to begin video playback.

- Right-click to open the playback virtual remote. Use the video control buttons to speed up or slow down the video.

3. Press ■ to stop playback and return to live viewing.
Quick Search

To perform a quick search:

1. Press and hold the Search Button ( ) on the front panel of the system for 2 seconds. The Time Input menu appears.

   ![Time Input Menu]

2. Double-click the INPUT field, and use the virtual keyboard to enter the date and time that you wish to search for.

Event Record Search

The Event Record Search option allows you to search for any events that occurred on the system.

To perform an Event Record Search:

1. Press the SEARCH button ( ) on the front panel or remote control ( ).

   ![Event Record Search Menu]

2. Under SEARCH MODE, click the +/- buttons and select EVENT RECORD (default).
3. Click ENTER to begin the search.

4. Double-click on the event in the calendar that you wish to view (events are highlighted in red).
**Event Preview Search**

The Event Preview search allows you to view searched results as a thumbnail preview. This works in single-channel search only.

**To perform a preview search:**

1. Press the Search button (-search icon) on the front panel or remote control (search icon).

2. Beside the “Day” field, click on the date you wish to search for. Then scroll DOWN on the mouse to select the Hour. Select the desired hour. Scroll DOWN again to select the desired minute. You can also press the -/+ button on the virtual remote to select the hour and minute.

3. Right-click to open the virtual remote, and then click on the channel that you wish to preview search.

4. Select the preview image that you wish to watch. A box outlines the preview image to indicate the selection.

5. Right-click to open the virtual remote, and then click the Enter button to begin viewing.

6. To exit, right-click to open the virtual remote, and then click the Stop button (stop icon).
**Motion Area Search**

The Motion Area Search allows you to search for video with a pre-defined criteria.

**To begin Event Area Search:**

1. Press the Search button ( ) on the front panel or ( ) on the virtual remote.
2. Click on the date that you wish to search for. Right-click to open the Virtual Remote. Click the + button to select the hour. After you have selected the hour, click the + button again to select the desired minute you wish to search under.
3. Click the Event Select button.

4. Double-click the Search Mode field, and click +/- to select **MOTION AREA**. Note that by default, the entire motion area is selected by default.

5. In the Motion Area window, configure the area of the screen that you wish to search for motion (see below).

6. Press the **MENU** button to search for video with your particular settings.
External Search

External search allows you to search for video footage stored on an external device such as an external hard drive. Note that the DVR can only search for video that is from the same model DVR.

Prerequisites:
• A USB 2.0 hard drive with data backed up from the same model DVR

To perform an External Search:
1. Connect a external USB hard drive to the USB port on the front or rear panel of the system.
2. Right-click to open the virtual remote, and then click .
3. Enter your system password if required.
4. In the EXTERNAL SEARCH menu, click -/+ and select the external device that you wish to search.
5. Press the ENTER button. The system scans the external hard drive.
6. The Time Search menu appears. Perform a search to search for videos on your external hard drive.

Event Source Search

Event Source search allows you to search for video on channels that have an alarm, motion, or video loss event.

To perform an Event Source search:
1. Press the Search button ( ) on the front panel or ( ) on the virtual remote.
2. Click on the date that you wish to search for. Right-click to open the Virtual Remote. Click the + button to select the hour. After you have selected the hour, click the + button again to select the desired minute you wish to search under.
3. Click the Event Select button.
4. Under SEARCH MODE, click -/+ and select EVENT SOURCE.
5. Under Event Status, configure the following:
   • ALARM: Select the alarm input you wish to search (input 1~4)
   • MOTION: Select the channel that you wish to search for motion (channels 1~16)
   • VLOSS: Select the channel that you wish to search for Video Loss (channels 1~16)
6. Press MENU to begin the search.
Setting up Sequencing

SETTING UP SEQUENCING

Sequencing allows you to view channels in a rotating interval. There are three modes of sequence setup: sequence mode, shift mode, and event mode.

Sequence mode & Shift mode

Sequence mode allows you to display channels on a regular rotating interval. For example, the monitor can display channels 1~4, then channels 5~8. Shift sequence mode retains the same split screen view, but the channels change continuously within each channel cell.

To set up regular sequence mode:
1. Press the MENU button on the remote or front panel to open the main menu. Press ENTER
   • If using a mouse, right-click to open the virtual remote, then click MENU.
2. Click DISPLAY.
3. Click the SWITCH tab.
4. Beside DEVICE, select MAIN to configure the main monitor or SPOT to configure the spot monitor. If you select SPOT, ensure a spot monitor is connected to the SPOT OUT port on the rear panel.
5. Configure the following:
   • DWELL TIME: Select the dwell time (the time duration before the channel changes).
   • MODE: Select SEQUENCE or SHIFT.
   • SPLIT MODE (MAIN configuration only): Select the desired split-screen style.
   • USE CHANNEL: Select the channels you want to view in sequence view.
6. Press MENU on the remote or click ENTER.
7. Exit to the main viewing window. Press and hold the DISPLAY button for 2 seconds on the remote or front panel to begin sequence view. To exit sequence view, press DISPLAY on the remote or front panel or press the camera number on the remote.
Event View

Event view allows the channel that detects an event (i.e. motion or alarm) to appear in the main channel. This is especially useful if you set up sequence in single-channel view, but want to see immediately any channels that detect motion.

To set up Event sequence mode:
1. Press the **MENU** button on the remote or front panel to open the main menu.
   - If using a mouse, right-click to open the virtual remote, then click **MENU**.
2. Click **DISPLAY**.
3. Click the **SWITCH** tab.
4. Beside DEVICE, select **MAIN** or **SPOT**.
5. Configure the following:
   - **MODE**: Select **EVENT**
   - **SPLIT MODE** (MAIN configuration only): Select the desired split-screen style.
   - **USE CHANNEL**: Select the channels you want to view.
6. Click the **EVENT** tab.
7. In the MOTION column, ensure the number matches the channel number as shown in the image above. For example, Channel 1 will have a Motion value of 1 etc..
8. Click **ENTER**.
9. Exit to the main viewing window. Press and hold the DISPLAY button for 2 seconds on the remote or front panel to begin sequence view. To exit sequence view, press DISPLAY on the remote or front panel or press the camera number on the remote.

**Configuring the EVENT tab**

The EVENT tab allows you to set up cameras to trigger each other. For example, you can set up Camera 1 (front door) to trigger Camera 5 (side door) to be the main channel when someone approaches Camera 1 (front door).

**Scenario: Camera 1 triggers camera 5 to be the main camera**

1. Beside CH1, select camera 5 under MOTION.

   ![Display screen showing camera selection](image)

   Camera 1

   This tells camera 1 that if camera 5 detects motion, then camera 1 becomes the main channel.

2. Click ENTER to save your settings.

**Connecting a SPOT OUT / CAMERA OUT monitor (DH230/250)**

The SPOT OUT and VIDEO OUT ports allow you to connect addition monitors as outputs.

![DH230 and DH250 diagrams](image)
Setting up Motion Recording

Setting up Motion Recording

Motion recording allows the system to mark events as motion recording. This allows you to search for footage that only has movement.

**Step 1: Configure Camera motion sensitivity & Configure Event frame rates**
1. Press the **MENU** button on the remote or front panel to open the main menu.
   - If using a mouse, right-click to open the virtual remote, then click **MENU**.
2. Click **CAMERA**.
3. Click the camera number button to select the camera you wish to configure.
4. Click the ( ) button to select the entire screen (selected by default) or click ( ) to select certain portions of the screen by double-clicking the portions of the screen you wish to enable motion.
5. Beside MOTION LEVEL, press -/+ to adjust the motion sensitivity.
6. Click **ENTER** to save your settings.
7. Click **RECORD ➔ DAY**.

**NOTE**: You can also click on **RECORD ➔** under SCHEDULED USE, select **ON**. Click the **NIGHT** tab and follow the same instructions below.
8. Under EVENT, enter the number of frames you want the camera to record in if it detects motion, under F/S. Repeat for any other cameras that you wish to enable motion recording.

**NOTE:** If you want to disable continuous recording, under CONTINUOUS, under F/S, select OFF. This causes the system to record only when the cameras detect motion.

9. Under QUALITY, enter the desired video quality when the camera detects motion.
10. Click ENTER to save your settings.

**Step 2: Configure Cameras that have motion Enabled**
1. Click the DAY EVENT tab.
2. Ensure that under MOTION, the camera number matches the number in CH.

**IMPORTANT**
It is critical that the camera number under MOTION is the same as the channel number you are configuring.

This ensures that when there is motion to that particular camera, that it will trigger motion recording.

**Step 3: Configure Schedule settings**
1. Click SCHEDULE.
2. Double-click the days that you wish to enable Motion recording.

3. Configure the following:
   - **MODE**: Click the +/- buttons to change to apply DAY recording, or NO REC to disable recording. If you configured DAY recording in Step 1, select DAY.

   **NOTE**: You cannot configure NIGHT recording to have a beginning and end time. However, if NIGHT recording is chosen, the NIGHT recording parameters still apply to the schedule.

   - **BEGIN**: Enter the time you want the scheduled recording to start.
   - **END**: Enter the time you want the scheduled recording to end.

4. Click **ENTER** to save your settings.

**Final Result**

When the camera detects motion, the ( ) symbol appears, and the channel number turns red ( ). The channel number turns red to indicate alarm recording. During video search, motion events will appear as EVENT. If the channel number does not turn red, then motion recording has not been enabled. Double-check to see that you have enabled motion recording in Step 1.
### Triggering secondary cameras in Motion recording

You can configure secondary cameras to begin motion recording when surrounding cameras detect motion. For example, if Camera 2 and 3 detects motion, the system can trigger Camera 1 to begin recording as an event.

**To configure custom Motion recording settings:**

1. Under the DAY EVENT or NIGHT EVENT tab, click ( ) beside the channel that you wish to configure.

![Event Edit icon](image)

2. Under MOTION, ensure that whatever channel you are configuring is selected. In this example, Camera 1 must be selected, since it is the camera you are configuring. Select cameras 2 and 3.

![Select cameras 2 and 3.](image)

3. Click **ENTER** to save your settings.

**Final Result**

When camera 2 and 3 detects motion, camera 1 begins recording as an event.
Triggering cameras to record during Video Loss

If video loss occurs, the system can trigger secondary cameras to begin recording as an event. For example, if a vandal attempts to cut the camera wiring, as soon as the cable wire is cut, the system triggers other cameras to detect as a motion event.

1. Under the DAY EVENT or NIGHT EVENT tab, click ( ) beside the channel that you wish to configure.

2. Under VLOSS, ensure that whatever channel you are configuring is selected. In this example, Camera 1 is selected. Select cameras 2 and 3.

Example

3. Click ENTER to save your settings.

Final Result
When video loss occurs on cameras 2 or 3, camera 1 begins recording as an event.
Using the Main Menu

USING THE MAIN MENU

To open the Main Menu:

- Press the MENU button on the front panel or the remote control

1. **DISPLAY**: Adjust OSD borders, split-screen configuration, and Auto Sequence settings.
2. **CAMERA**: Adjust brightness, camera titles, color, contrast, title, PTZ settings, and enable/disable convert.
3. **RECORD**: Enable/disable recording for each camera, configure the recording quality, frame rate, and motion.
4. **SCHEDULE**: Customize DAY and NIGHT recording modes according to a daily or weekly schedule.
5. **DISK**: Configure hard drive mirroring options, monitor hard drive status, and setting hard drive modes (i.e. setting hard drive to master or slave)
6. **NETWORK**: Configure IP, email, and DDNS settings.
7. **DEVICE**: Configure post recording time, key sensitivity, audio recording, and alarm settings.
8. **SYSTEM**: Configure video output settings, audio recording, alarm settings and PTZ event settings.
DISPLAY

Use the Display menu to configure the OSD and Auto Sequence settings.

The Display menu categorizes in 3 sections --- “GENERAL”, “SWITCH” and “EVENT”.

GENERAL

To configure the “GENERAL” display tab:

1. Select the GENERAL tab, and configure the following:
   • STATUS BAR: Select to Show or Hide the status bar on the OSD.
   • CAMERA INFO: Select to show the CAMERA NUMBER, or the CAMERA TITLE or both.
   • BORDER LINE: Set the color for the borders of the OSD.
   • BACKGROUND: Set the background color for disconnected cameras on the main display.
   • OSD ALIGNMENT: Configure the DVR’s main output to output to a VGA or CCTV monitor. If you use a VGA monitor, select OVERSCAN. If you use a CCTV monitor, select UNDERSCAN.
   • SPLIT MODE: Select the Split modes that you want activated when you press the DISPLAY button on the remote.

2. Click ENTER to save your changes and exit.

SWITCH / EVENT

The SWITCH and EVENT tab allows you to configure Sequencing display options for the main and spot out monitor.

For details on setting up sequencing mode, see “Setting up Sequencing” on page 30.
Using the Main Menu

**CAMERA**

Configure various camera settings, such as brightness, contrast, and title.

**To configure camera settings:**

1. Click the camera number button to configure the desired camera.

2. Configure the following:
   - **BRIGHTNESS, CONTRAST, COLOR**: Adjust from 0~100.
   - **MOTION LEVEL**: Select the motion sensitivity of the system. The greater the number, the more sensitive the system is to motion. By default, the motion level is set to 20.
   - **MOTION GRID**: Select the area of the screen that you wish to enable motion recording.
   - **TITLE**: Use the alpha-numeric buttons on the remote control to enter a name/title for the camera. Press ◀▶ to move the cursor left/right. If you make a mistake, press CANCEL/ESC to return to the Main Menu and start again.

3. Repeat for other camera connected to the system.

4. Click ENTER to save your settings. Press CANCEL/ESC to close remaining menu windows.

**PTZ**: Click the SETUP button to configure your PTZ settings. Enter your PTZ ID, Model, and Baudrate. The PTZ ID should match the camera channel to which you have connected the PTZ camera.

**NOTE**: PTZ devices are connected to the RS-422 ports located on the rear panel. Multiple PTZ cameras are connected by daisy-chaining the camera connection in the RS-422 ports.

**NOTE**: For details on connecting PTZ cameras, see “Appendix F: Connecting PTZ Cameras” on page 155.

**TITLE**: Enter the desired camera title.
**GENERAL**

To configure the GENERAL tab:

1. Click the **GENERAL** tab (selected by default).
2. Configure the following:
   - **SCHEDULE USE**: Select **ON** to configure the NIGHT and NIGHT EVENT tab. By default, Schedule Use is turned off.
   - **BOOTUP RECORD**: Turn this setting **ON** (default) so that the DVR begins recording automatically at system bootup. If this setting is turned off, the DVR will not record until you press the record button.
   - **DISK OVERWRITE**: Turn this setting **ON** (default) so that the hard drive automatically erases the oldest data once the hard drive is full (first in first out). If Disk Overwrite is turned off, the system will stop recording once the hard drive is full.
   - **AUTO DELETE**: Configure the duration the system should keep the data on the hard drive before it is deleted. Select from 12 hours ~ 30 days. For example, if you choose 12 hours, the system keep the last 12 hours of recording, deleting the older footage.
   - **PRE RECORD**: Configure the amount of time the system records before an event recording. Select from 5 seconds ~ 300 seconds. For example, if an event occurred at 12:00:00, and you have the pre-recording time marked at 5 seconds, then during the search, the video will begin at 11:59:55.
3. Click **ENTER** to save your changes.
   - **POST RECORD**: Configure the amount of time the system marks an event after an event occurs. Select from 5 seconds ~ 300 seconds.

**MODE**

To configure the MODE tab:

**Prerequisite**: Stop the system recording before configuration. If the system is still recording, you will not be able to edit the settings in the MODE tab.

1. Click the **MODE** tab.

2. Beside the camera number that you wish to configure, set the following:
   - **RES. MAX F/S**: Select the frame rate and resolution the channel should record in.
     - As you adjust the frame rates, the frame counter tells you how many frames you have left to assign to remaining channels (Used FPS).
   - **Used FPS**
   - **Total FPS**
   - If you go over the total frame count, a warning message appears. Click YES to disable the last channel so that the remaining channels can use the extra frame rates.
3. Press **<**/**>** on the front panel, or press the **●** button on the remote control to resume Continuous Recording.
**DAY**

**Configuring the DAY tab**

The DAY tab allows you to configure how the system will record during DAY recording in the Scheduled recording menu.

**To configure the DAY tab:**

1. Click the **DAY** tab.

2. Beside the desired channel you wish to configure, adjust the following for Continuous and Event recording:
   - Under **F/S**, select the frames per second of the particular channel during DAY recording.
   - Under **QUALITY**, select the recording quality during daytime recording.

3. Click **ENTER** to save your settings.

**DAY EVENT**

**Configuring the DAY EVENT tab**

The Day Event tab allows you to configure how the system will record an event if an alarm trigger, motion or video loss occurs when the DVR is in “DAY” recording mode. This setting is used in the SCHEDULE menu, where you can assign the system to record in “DAY” mode.

**To configure the DAY EVENT tab:**

1. Click the **DAY EVENT** tab.

2. Configure the following for each channel:
   - **ALARM**: Select from 1–4 or **ALL**. This tells the system to mark the video as an event when an alarm input triggers for the selected channel.
   - **MOTION**: Select the camera that you want to trigger the camera being configured to record as an event. For example, if you are configuring channel 2, and enter channel 8 in the MOTION column, this tells the system that when a video loss occurs in channel 8, it will also cause channel 2 to record, and mark the recorded video as an event.
   - **VLOSS**: Set the camera that you want to trigger the camera you are configuring to record when the camera detects video loss. For example, if you are configuring channel 1, and enter channel 8 in the VLOSS column, this tells the system that when a video loss occurs in channel 8, it will also cause channel 1 to record, and mark the recorded video as an event.

   - By default, the VLOSS channels are paired to each other (i.e. Channel 1 has “1” under VLOSS, Channel 2 has “2” under VLOSS etc.)

   - Indicates multiple devices are configured (See Event Edit below).
• \( \text{EVENT EDIT} \): Click this icon to open the \text{EVENT EDIT} menu.

**About the EVENT EDIT window**

The EVENT EDIT window allows you to have other cameras trigger the camera you are configuring, to record as an event. For example, you can tell the system to have camera 1 record, when there is video loss in camera 3. Likewise, you can tell camera 1 to record as an event when there is motion detected in camera 5.

**To configure the EVENT EDIT window:**

1. Configure the following:
   - **ALARM IN**: Select the Alarm In devices that, when triggered, will cause the camera you are configuring to record as an event.
   - **MOTION**: Set the camera (i.e., Camera A) that you want to trigger the system to record when the camera (Camera A) detects motion. For example, if you are configuring channel 1, and enter channel 8 in the motion column, this tells the system that when a motion event occurs in channel 8, it will cause channel 1 to record, and mark the recorded video as an event.
   - **VLOSS**: Select the channels to monitor for Video Loss. For example, by default, all of the VLOSS settings are selected. This means that if any of the cameras are disconnected (i.e., if a vandal cuts a camera wire), it will trigger an event recording on the camera you are currently configuring.

**NIGHT**

**Configuring the NIGHT tab**

The NIGHT tab allows you to configure how the system will record during Night recording in the Scheduled recording menu.

**To configure the NIGHT tab:**

1. In the RECORD menu, click the **GENERAL** tab.
2. Beside SCHEDULE USE, select **ON**.
3. Click the **NIGHT** tab.
4. Beside the desired channel you wish to configure, adjust the following for Continuous and Event recording:
   - Under **F/S**, select the frames per second of the particular channel during NIGHT mode recording.
   - Under **QUALITY**, select the recording quality during NIGHT mode recording.
5. Click **ENTER** to save your settings.
NIGHT EVENT

Configuring the NIGHT EVENT tab

The NIGHT EVENT tab allows you to configure how the system will record during Night EVENT recording in the scheduled recording menu.

1. Configure the following:
   - **ALARM**: Select from 1~4 or ALL. This tells the system to mark the video as an event when an alarm input triggers for the selected channel.
   - **MOTION**: Select the camera that you want to trigger the camera being configured to record as an event. For example, if you are configuring channel 2, and enter channel 8 in the MOTION column, this tells the system that when a video loss occurs in channel 8, it will also cause channel 2 to record, and mark the recorded video as an event.
   - **VLOSS**: Set the camera that you want to trigger the camera you are configuring to record, when the camera detects video loss. For example, if you are configuring channel 1, and in the VLOSS box, you select channel 3, this means that when channel 1 detects movement, channel 3 will begin to record as a motion event.

   (See “About the EVENT EDIT window”)

   - \(\text{EVENT EDIT}\) : Click this icon to open the EVENT EDIT menu

About the EVENT EDIT window

The EVENT EDIT window allows you to trigger other cameras to record if an event is detected. For example, if the camera outside your garage (camera 5) detects movement, you can trigger the camera inside the garage (camera 6) to begin recording as an event.

To configure the EVENT EDIT window:

1. Configure the following:
   - **ALARM IN**: Select the Alarm In devices that will trigger an alarm recording.
   - **MOTION**: Select the camera that will begin recording when motion is detected.

   For example, if you are configuring channel 1, and in the MOTION box, you select channel 3, this means that when channel 1 detects movement, channel 3 will begin to record as a motion event.

   - **VLOSS**: Select the channels to monitor for Video Loss. For example, by default, all of the VLOSS settings are selected. This means that if any of the cameras are disconnected (i.e. if a vandal cuts a camera wire), it will trigger an event recording on the camera you are currently configuring.

2. Click **ENTER** to save your settings.
SCHEDULE
Set a custom recording schedule for the days of the week.

Pre-requisites:
• Ensure that you have configured the DAY and NIGHT recording settings in the Recording menu. Select NO REC to disable recording. For details, see “RECORD” on page 41.

CHART
To set a recording schedule in the CHART tab:
1. Click the CHART tab [default].
2. Double-click the day that you wish to configure.

3. Configure the following:
   • MODE: Click the +/- buttons to change to appl, DAY, NIGHT recording. Select NO REC to disable recording.
   
   NOTE: You cannot configure NIGHT recording to have a beginning and end time. However, if NIGHT recording is chosen, the NIGHT recording parameters still apply to the schedule.
   • BEGIN: Enter the time you want the scheduled recording to start.
   • END: Enter the time you want the scheduled recording to end.

4. Click ENTER to save your settings.

HOLIDAY
Configuring the Holiday schedule
The holiday schedule allows you to apply a custom recording schedule for a set duration. This is useful if you will be away from the system, and want to automate a specific recording schedule.

Pre-requisites:
• Ensure that you have configured the DAY and NIGHT recording settings in the Recording menu. For details, see “RECORD” on page 41.
• Ensure that you have configured a recording schedule in the CHART tab for each date (Sunday - Saturday).
To configure the Holiday schedule:
1. Click the HOLIDAY tab.

2. Configure the following:
   - **MODE**: Select the recording mode you wish to apply. Choose from OFF, DAY, NIGHT, SUNDAY-SATURDAY, or CUSTOM.
   - **MM/DD**: Enter the month and date you want the holiday recording to start.
   - **DAYS**: Enter how many days you want the holiday recording to last. For example, if you select 2 days, holiday recording will be enabled for 2 days, and then resume to the regular recording mode (continuous).

   **NOTE**: If a holiday schedule occurs on the same day as a weekday schedule, the holiday schedule overrides the weekday schedule.

3. Click ENTER to save your settings.
Using the Main Menu

**DISK**

Use the Disk menu to format the internal HDD, and configure Overwrite, Disk Monitor and Disk mirroring settings.

**DISK MANAGER**

**Disk Manager Tab**

The Disk manager tab allows you to view connected hard drives/ CD/DVD writers, configure hard drive mirroring, and hard drive health.

**Understanding the Status readings**

The Status column indicates devices that are connected to the system, and the health of the hard drive.

Below is a list of titles that you may see under the Status column:

- **CD/DVD**: A CD/DVD drive is connected to the system.
- **Unknown**: A new hard drive is installed, but not formatted.
- **Empty**: The hard drive has been formatted, but not currently used in the system.
- **Record Data**: There is data on the hard drive, but it is not currently used in the system to record.
- **Back up Data**: The hard drive has back up data stored.
- **Other Data**: The hard drive does not include backup or recording data.
- **Damaged**: The hard drive is unusable.

**Formatting a new hard drive**

You must format a new hard drive before it can be used for recording.

**To format a new hard drive connected to the system:**

1. Install the new internal hard drive to the DVR.
2. Under DEVICE, select the hard drive. The naming convention looks something like this: “INT-A: Unknown”.
3. In the ACTION field, click +/- and select Assign to Record.
4. Click Start to format the hard drive. After the formatting is complete, the hard drive shows up in the RECORDING DISK tab.

**Mirroring (RAID 1)**

The mirroring feature allows two hard drives to write duplicate data to onto each other. In the event that one hard drive fails, there will always be a back up hard drive with identical data.

**To set up disk mirroring:**

1. Ensure you have two internal hard drives installed in the system.
2. Under DEVICE, select the two hard drives you wish to set up for disk mirroring.
3. In the ACTION field, click +/- and select Assign to R&M (R&M stands for Record and Mirroring).

**NOTE**: The two hard drives should be identical in brand/model/capacity. If one hard drive is smaller, the system will recognize the smaller hard drive as the maximum storage capacity.

4. Click Start to format the hard drive. After the formatting is complete, the hard drives will be set up in mirror mode.
Using the Main Menu

**Record + Mirror**

The Record+Mirror function allows you to turn a hard drive that is assigned as a recording hard drive, into a mirroring hard drive.

1. Ensure you have two internal hard drives installed in the system.
2. Under DEVICE, select the hard drive you wish to set up for disk mirroring.
3. In the ACTION field, click +/- and select **MIRROR ON INT-A.**

**NOTE:** The two hard drives should be identical brand/model/capacity.

4. Click **Start** to format the hard drive. After the formatting is complete, one hard drive will be set up for mirroring, and the other for recording.

**Initializing (formatting) a hard drive for backup**

Before the system can detect an internal hard drive, it must be initialized.

**To initialize a hard drive:**

1. Connect the internal hard drive to the system.
2. Under DEVICE, select the drive you wish to initialize.
3. In the ACTION field, click +/- and select **Initialize for backup.**
4. Click **Start** to begin formatting.

**Link Record Disk**

The Link Record Disk function allows you to install a hard drive from a different DH230 series DVR without formatting. This is useful if you have several DH230s, and wish to swap hard drives for viewing/backup purposes.

**To use the Link Record Disk function:**

1. Connect the internal/external hard drive to the system.
2. Under DEVICE, select the drive you wish to initialize.
3. In the ACTION field, click +/- and select **Link Record Disk.**
4. Click **Start** to begin the process.

**Limitations of the Record Disk function:**

- You must remove the original hard drive before installing the new hard drive from another system.
- The hard drive must be from the same DVR series.

**Recording Disk**

The Recording Disk tab lists the drives that are currently used for system recording.

The Recording Disk menu displays the following:

- **SIZE, RANGE:** Displays the hard drive size, and the duration of recording.
- **DEVICE:** Displays the type of device connected to the system.
- **STATUS:** Displays the hard drive health status.

- **STABLE:** The hard drive works properly.
- **SYNC:** The system is copying data from the master to slave hard drive.
- **RE-SYNC:** The system is forcing pending buffered disk writes to the new hard drive.
- **RECOVER:** The system is forcing pending buffered disk writes to the slave drive.
- **FAULTY:** Hard drive error.
- **ACTION:** Click the **REMOVE** button to unmount a hard drive. Click **YES** when the confirmation window appears to unmount the hard drive from the system.
### NETWORK

Configure network and DDNS options.

<table>
<thead>
<tr>
<th>ETHERNET</th>
<th>GENERAL</th>
<th>EMAIL</th>
<th>SMTP</th>
<th>DDNS</th>
</tr>
</thead>
<tbody>
<tr>
<td>CONFIG</td>
<td>STATIC IP</td>
<td>DHCP</td>
<td></td>
<td></td>
</tr>
<tr>
<td>IP ADDRESS</td>
<td>192.168.10.15</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>NETMASK</td>
<td>255.255.255.0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GATEWAY</td>
<td>192.168.10.1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>PRI. DNS SERVER</td>
<td>192.168.0.5</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SEC. DNS SERVER</td>
<td>210.220.163.82</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### ETHERNET

The ethernet tab displays the current system IP, netmask, gateway and DNS server IP.

**Configuring Network Type: STATIC vs DHCP**

The system has the ability to operate in DHCP mode and Static IP mode. DHCP allows the router to assign an IP to the DVR. Static IP mode fixes the IP of the DVR. Fixing an IP of the DVR ensures that the IP will not change.

**To change between Static IP and DHCP:**
1. Beside CONFIG, select **STATIC IP** or **DHCP**.
2. Click **ENTER** to save your settings.

**To manually configure IP settings:**
1. Beside CONFIG, select **STATIC IP**.
2. Configure the following:
   - IP ADDRESS
   - NETMASK
   - GATEWAY
   - PRI. DNS SERVER
   - SEC. DNS SERVER
3. Click **ENTER** to save your settings.

### GENERAL

The general tab allows you to configure the system port number, and various security settings.

**To configure the GENERAL tab:**
1. Configure the following:
   - **ACCESS PORT**: Enter the desired system port number (default port 80).
   - **BANDWIDTH**: Select from UNLIMITED, 4, 8, 16, 32, 64, 128, 256, 512 KBPS; 1, 2, 4, 8 MB.
   - **PING BLOCK**: Select **ON** to prevent outside connections from pinging the DVR.
   - **SCAN BLOCK**: Select **ON** to prevent outside connections from scanning the DVR.
   - **STREAM MODE**: Select from **DUAL** or **OPTIMIZED**. Select **OPTIMIZED** to allow the DVR’s built-in algorithm to determine the best video and audio streaming settings. Select **DUAL** to configure your own streaming quality under **STREAM PROPERTY**.
   - **STREAM PROPERTY**: Configure the frame rate the video streams during remote viewing. To configure the Stream Property, Under **STREAM MODE**, select **DUAL**. Select the video streaming quality (choose from Low~Ultra). The higher the video quality, the greater the bandwidth consumption.
2. Click **ENTER** to save your settings.
EMAIL

The DVR can send out email notifications when a motion or alarm event occurs.

To use the Digimerge email server (recommended):
1. Beside USE, select DEFAULT.
2. Configure the following:
   - EVENT: Select how frequent you want the system to send out email alerts. Note that the system only sends out a email notification if there is an event trigger (i.e. motion or alarm trigger).
   - Log: Select how long the system logs should be (select from 1 day or 1 week).
   - Retry Count: Enter the number of times the system attempts to re-send the email notification.
   - Log (Email Source): Select the Log checkbox if you want the system to email a system log.
   - Attach Picture: Select ON for the system to attach an image in the email alerts.
   - Email Address: Enter up to 5 email addresses that will receive email notifications from the system.
3. Click ENTER to save your settings.

Event Edit ( ) icon

To configure the EVENT EDIT (EMAIL) window:
1. Configure the following:
   - ALARM IN: Select the alarm in devices that will cause the system to send email notifications if an alarm is triggered.
   - MOTION: Select the channels that will cause the system to send email notifications if motion is detected.
   - SYSTEM: Select the events that will cause the system to send out email notifications. For a list of icons and what they mean, see the next page.
2. Click ENTER to save your settings.
What the SYSTEM icons mean:

1. HDD DISK FAIL: A hard drive error occurred.

2. RECORD SYSTEM FAIL: The system stopped recording.

3. TEMPERATURE WARNING: The system is overheating.

4. VOLTAGE WARNING: There was a surge in electrical output.

5. LOW RTC BATTERY WARNING: The system’s internal clock battery is low.

6. EXTERNAL DEVICE EVENT: A USB device has been removed.

7. NETWORK LINK DISCONNECT: The ethernet cable was unplugged.

To use a custom SMTP email server:

1. In the EMAIL tab, select SMTP.

2. Click the SMTP tab.

3. Configure the following:
   - **Server**: Enter the SMTP server name.
   - **Port**: Enter the SMTP port number.
   - **Authentication**: Select ON/OFF.
   - **User ID**: Enter your SMTP user ID.
   - **Password**: Enter your SMTP password.
   - **Send Test**: Click the Start button to send out a test email to your SMTP email account.

4. Click **ENTER** to save your settings.
DDNS

IMPORTANT
Digimerge DDNS is the only DDNS service supported by Digimerge. Digimerge will not provide support for DYNDNS or any other DDNS services. Please contact your DDNS provider for support for other DDNS services.

Configure Digimerge DDNS settings.

**NOTE:** You must register for the FREE Digimerge DDNS service prior to configuring DDNS settings.

To configure DDNS settings:
1. Under USE, select DIGIMERGE.
2. Under DOMAIN NAME, enter only the first portion of your DDNS domain from the confirmation email. For example, if your domain name is tomsmith.digimerge.net, you only need to enter tomsmith in the text field.
3. Under USER ID, enter your Digimerge DDNS user name.
4. Under PASSWORD, enter your Digimerge DDNS password.
   **NOTE:** Obtain your Digimerge DDNS user name and password from the confirmation email.
5. Under UPDATE TEST, click **START**. If successful, you will see “GOOD.” If unsuccessful, you will see “ERROR.” If you receive an error, please check your network connections and carefully re-enter your Digimerge DDNS information.
6. Click **ENTER** to save your settings.

Connecting to your system

After you have port forwarded the required port, created a DDNS account, and enabled DDNS on your system, you must enter the DDNS URL into Internet Explorer to access your DVR.

The DDNS URL must include **http://**, the name of your DDNS URL, **followed by a colon**, then the **port number of your DVR**.

For example:

```
http://tomsmitth.digimerge.net:80
```

**NOTE:** If you change your default port number (port 80) to a different port, you still need to enter your port number after the DDNS address.

Entering DDNS information using the remote

- Press the + / - buttons to enter alpha-numeric characters.

**OR**

- Press the number buttons on the remote to enter letters and numbers.
- Press the arrow keys to move to the next character.
**DEVICE**

Configure Alarm Out, Alarm Buzzer, and alarm input settings.

**GENERAL**

The GENERAL tab allows you to configure Post Recording time, Audio recording, Key Tone (key “beeps”), and Key Sensitivity.

1. Configure the following in the General tab:
   - **DISPLAY:** Select the output resolution.
   - **AUDIO RECORD:** Select ON or OFF to enable or disable audio recording.
   - **KEYPAD MODEL:** Select the PTZ keyboard model and baud rate.
   - **EXTENDED DEVICE:** Select the desired device
   - **PTZ EVENT:** Select the duration of a PTZ event.
   - **ALARM OUT:** Select the duration of an alarm out event.
2. Click **ENTER** to save your settings.

**ALARM**

The ALARM tab allows you to configure the system Alarm Buzzer and Alarm Input type on each channel (i.e. N.O and N.C [normally open and normally closed] settings)).

1. Configure the following in the Alarm tab:
   - **INPUT:** Select the alarm type connected to the particular channel. Select from N.O or N.C (Normally Open, or Normally Closed).
   - **OUTPUT:** Select N.O (Normally Open) or N.C (Normally Closed). Under INACTIVE, select the event type (Manual or Event).
   - **BUZZER:** Select ON/OFF. Under INACTIVE, select the event type (Manual or Event).
   - **CONTROL:** Turn the OUTPUT/BUZZER on or off. To enable the ON button, under INACTIVE select **MANUAL**.
2. Click **ENTER** to save your settings.
3. Click the EDIT EVENT icon ( ) beside OUTPUT/BUZZER to configure the actions that follow when an alarm output occurs / buzzer. The alarm output must be set to N.C or N.O before you can access the Edit Event window.

4. Configure the following in the EVENT EDIT (ALARM OUT 1) Window:
   - **ALARM IN**: Select the other alarms that will also trigger when Alarm OUT 1/BUZZER activates.
   - **MOTION**: Select the cameras that will cause ALARM OUT 1/BUZZER to activate when motion is detected.
   - **VLOSS**: Select the cameras that will cause ALARM OUT1/BUZZER to activate when video loss occurs in one of the cameras.
   - **SYSTEM**: Select the events that will cause ALARM OUT 1/BUZZER to activate.

5. Click ENTER to save your settings. Press CANCEL/ESC to close remaining menu windows.

---

**PTZ EVENT**

The PTZ Event menu allows you to configure the PTZ camera to go to a pre-defined pre-set or tour setting when an event occurs. For example, if camera 1 detects movement, the PTZ camera (camera 2) will automatically pan towards the front door.

To configure the PTZ Event tab:

1. Configure the following:
   - **CHANNEL**: Select the channel number the PTZ camera is connected to.
   - **ACTIVE**: This setting instructs what action the PTZ camera performs when an event occurs. Select from NONE, GOTO or TOUR.
   - In the number field, enter the GOTO or TOUR preset number. This number is programmed into the PTZ by the user.
   - **INACTIVE**: This setting instructs what action the PTZ camera performs after an event has ended. Select from NONE, GOTO or TOUR.
   - In the number field, enter the GOTO or TOUR preset number. This number is programmed into the PTZ by the user.
2. **EDIT EVENT** ( ): Click this icon to open the PTZ EVENT EDIT window. This allows you to configure the type of events that will trigger the PTZ camera.

![PTZ EVENT EDIT window](image)

3. Configure the following:

   - **ALARM IN**: Select the alarms that triggers the PTZ camera to move to a pre-defined location when the Alarm Input triggers.
   - **MOTION**: Select the cameras that triggers the PTZ camera to move to a pre-defined location when the cameras detect motion.
   - **VLOSS**: Select the cameras that cause the PTZ camera to move to a pre-defined location when Video Loss occurs on the selected cameras.

4. Click **ENTER** to save your settings.

Alarm recording will take priority over continuous recording, even if a camera is disabled in standard recording parameters.

![TIP!](image)
SYSTEM

Configure System settings.

GENERAL

To configure general system settings:
1. Configure the following:
   • CONTROL ID: This setting allows you to pair a DVR with a remote. For example, if you have several DVRs in the same room, and you want to control them with one remote, you can pair the remote to the DVR, so that the remote will only control that particular DVR.
      To pair a remote to the DVR, enter a number from 00~99. Click ENTER to save your settings.
      On your remote control, press and hold the DVR ID button while pressing the number of the CONTROL ID. The Control ID number and the number you enter into your remote control must be the same.
   • DVR NAME: Enter the desired DVR name. This name will appear when you connect to the DVR remotely.
   • KEY TONE: Select ON/OFF to enable or disable the ‘beep’ when you press the buttons on the front panel.
   • PB DEINTERLACE: Turn this setting ON to reduce image flickering, with lowered picture quality. Turn this setting OFF to have better picture quality, but with some image flickering.
   • AUTO LOGOUT: Turn ON/OFF to enable or disable users from being automatically logged off of the system. Enter the desired time before a system logs a user off.
   • SMART MONITOR: Turn ON/OFF to show or hide the hard drive S.M.A.R.T status in the DISK menu.
   • KEY SENSITIVITY: Press +/- to increase or decrease the button sensitivity on the front panel of the system.

TIME

For more details, on setting the date and time, see “Setting the Time” on page 18.

ACCOUNT

Only the ADMIN can configure user authorities on the system.

To configure user and account settings:
1. Select the ACCOUNT tab, and configure the following:
   • USER/NAME: Click the -/+ button to configure the user type. You can change the default admin login name. Configure up to 5 users.
   • ACTIVATE: Select ON/OFF to enable or disable Users 1~5.
   • PRIVILEGE: Select the type of menus that the user can control.
   • NETWORK: Enter the network password for the particular user, or deny users entirely from connecting remotely. Select from DENY, CUSTOM P/W, or SYSTEM P/W.
   • CHANNEL (COVERT): Define which channels can be seen by the particular user. Checked channels are visible; unchecked channels are hidden.
   • PASSWORD: Enter your new user or admin password.
2. Click ENTER to save your settings.
Using the Main Menu

**UPDATE**

Use the Update menu to upgrade system firmware.

**NOTE:** The system supports most major brands of USB flash drives with a capacity of 10 MB ~ 16 GB.

**To upgrade firmware:**
1. Download the latest firmware update from the Digimerge website.
2. Copy the firmware to a blank USB flash drive.
   **NOTE:** Do not have any folders on the USB flash drive—just the firmware file.
3. Connect the USB flash drive to the USB port on the front or back panel.
4. Stop all recording on the system.
   **NOTE:** You must stop all recording in order to perform the upgrade.
5. Open the Main Menu and select **SYSTEM**.
6. Under the **UPDATE** tab, select **UPDATE**.
7. Select **START** and press the **ENTER** button. Firmware upgrade begins. **Do not** remove the USB flash drive until the upgrade process is complete. **Do not** press any buttons or power off the system during the upgrade process.

When upgrade is finished, click the **REBOOT** button in the prompt window to restart the system.

**INFO**

View important system information:

- **S/W VERSION**: The current system firmware version.
- **DOMAIN NAME**: Your Digimerge DDNS domain name.
- **MAC**: The physical address of the DVR on your network.
- **LANGUAGE**: The current system language.
- **NETWORK**: The IP address of the system
- **RECORD DISK**: HDD, size and space remaining.
- **DISK SUMMARY**: The status of the HDDs, and what state they are in.
  - **STREAM**: the hard drive is in recording mode
  - **0 MIRROR**: the hard drive is in RAID mode
- **SYSTEM HEALTH**: Indicates system temperature and voltage.
- **DISK ORDER**: Displays the internal system disk order.
- **EXTERNAL 1 & EXTERNAL 2**: Displays devices connected to the USB port.
- **USB (FRONT)**: The status of the USB port on the front panel.
- **USB (REAR)**: The status of the USB port on the rear panel.
Backup critical video data on your system to a USB flash drive, external USB HDD, FTP server, or the CD/DVD-RW drive in the system (specified models only. Some models may not ship with a built-in CD/DVD-RW drive).

**NOTE:** The system supports most major brands of USB flash drives with a capacity of 10 MB ~ 4 GB. Most major brands of USB HDDs and CD/DVD-RW drives are supported.

### Backing up to a USB Device or CD/DVD Burner

**To backup recorded video:**

1. Connect a blank USB flash drive / external hard drive to the USB port on the front panel, or insert a blank CD/DVD into the CD/DVD drive.
2. If using a USB drive, format the USB flash drive if you have not already done so.
3. Press the **BACKUP** button on the front panel. Enter the system password if required.
4. Under DEVICE, select the name of your USB device.
5. Under CHANNEL, select the channels you wish to back up.
6. Under SELECT, select **ALL DATA** to back up all video data within a time range, or select **EVENT ONLY** to back up videos marked as an event.
7. Under FILE, select from ‘**DEFAULT WITH MCDPLAYER**’ to backup the file with MCD Player; ‘**DEFAULT WITHOUT MCDPLAYER**’ to backup the file without MCD Player, or select **AVI**.

   **NOTE:** When selecting “AVI”, the system automatically converts the file from the proprietary format, to a standard AVI file format. AVI file formats are recognized by most computers, and does not require an extra player to run the video.

8. Under RANGE, enter date and time for the system to scan for video
9. Click the **START** button.
10. Once backup is complete, press **CANCEL/ESC** to close remaining windows.
11. You will be prompted to re-start recording on the system. Press **CANCEL/ESC** to close the prompt, and ◀/● to resume Continuous Recording; press ◀/▶ to resume Schedule Recording.

**ATTENTION:** You must **STOP ALL RECORDING** on the system prior to backing up any video data to an external USB HDD or external USB CD/DVD-RW drive.
Backing up to an FTP Server

**NOTE:** Using the system locally, you can only configure the backup interval and test the connection for an existing FTP connection. To setup automatic backup to an FTP server, you must use the CMS-DH software. For instructions, see “Configure Backup to FTP Server” on page 83.

To test an existing FTP connection:
1. Press the **BACKUP** button on the front panel. Enter the system password if required.
2. Select **AUTO BACKUP**.
3. Under **DEVICE**, click **SETUP**.
4. Under **TEST**, click **START** to test the FTP connection. Good is displayed if FTP connection is working. If an error is displayed, check your FTP settings and ensure that the system can be accessed through CMS-DH.

To configure a schedule for FTP backup:
By default, the system will backup all video data to FTP in 24-hour intervals. You can configure a daily schedule to only backup data from a specified time range.

**NOTE:** FTP connection must be active before scheduling FTP backup.

1. Press the **BACKUP** button on the front panel. Enter the system password if required.
2. Select **AUTO BACKUP**.
3. Under **RANGE**, select **ENABLE** and configure the start time and end time (24-hour clock) for daily backups.

**NOTE:** When you configure FTP backup schedule, the system will backup future data only. For example, if it is 12:00 and you set an interval of 15:00 to 20:00, the system will begin to backup recordings at 15:00. If the interval has already started, the system will not begin backup until the next day.

4. Under **ACTION**, click **START**.

**NOTE:** The message “+1 Day” appears when the start time specified is later than the end time. The system will still create backups.

5. Click \[\] to save your changes.
Viewing Backup Video

Along with copying the files, the system adds a Backup Video Player (McdPlayer) to the USB flash drive, external HDD, and external USB CD/DVD-RW drive. Use the Video Player to view the backed up video files on your PC.

**NOTE:** You can also view the files using the browser-based remote surveillance software.

**To view backup video:**

1. Connect the USB flash drive or external USB HDD with the backed up video data to your PC; or insert the CD/DVD-R/W disc into your PC’s CD/DVD-RW drive.

2. McdPlayer should launch automatically. If Autorun does not start, search the drive/disc and double-click `mcdplayer.exe` to launch the Backup Video Player. McdPlayer launches and begins to load your backed up video.

   **NOTE:** If the drive contains more than one video file, first select the file and click **OK**.

3. When the purple progress bar has loaded, you can begin to playback the video.

   **NOTE:** The "C" button stands for Capture. The "D" button stands for de-interlace.
Using MCD Player

MCD Player is a small application that the system places on your USB flash drive when you backup critical video.

To use MCD Player:

1. Connect the USB flash drive or external HDD with the backed up video data to your PC; or insert the CD/DVD-R/W disc into your PC’s CD/DVD-RW drive.
2. Double-click mcdplayer.exe to launch the Backup Video Player. The Video Player launches and begins to load your backed up video.

   **NOTE:** If the drive contains more than one video file, first select the file and click **OK**.

3. When the purple progress bar has loaded, you can begin to playback the video.
4. Use the playback buttons at the top of the main screen to control playback.

   - **R** : Reverse playback -4X
   - **R** : Reverse playback -2X
   - **R** : Reverse playback -1X
   - **H** : Backward step (frame-by-frame)
   - **H** : Forward step (frame-by-frame)
   - **P** : Forward play 1X
   - **P** : Forward play 2X
   - **P** : Forward play 4x

5. To view full-screen, click the **number buttons**. Click the split-screen buttons to view Quad and multi Split-Screen.
6. Click and drag the purple playback slider to pause, advance or restart playback.
7. Click **W** to for a watermark on the file. If the file has a watermark, the following prompt will appear: “Has not been tampered with.”
8. Click the **PRINT ICON** to immediately print a still frame from the video to your default printer.

   **NOTE:** The date and time will appear below the printed image.
Backup
CMS-DH CENTRAL MANAGEMENT SOFTWARE

CMS-DH is a central management software that allows you to view and manage up to 300 DH230 series DVRs.

System Requirements

Your system must meet the system requirements below:

Minimum system requirements
- Windows XP SP 1
- Pentium 4, 2.4Ghz
- 512 MB RAM
- 64 MB AGP video card
- 1024 x 768 monitor resolution
- Direct X 7.0
- 100MB Ethernet LAN
- 10 GB free storage space

Recommended system requirements
- Windows XP SP 1
- Pentium 4, 3.0 Ghz
- 1GB RAM
- 256 MB, PCI-E video card
- 1600 x 1200 monitor resolution
- Direct X 9.0
- 100MB Ethernet LAN
- 40 GB free storage space

Prerequisites
- Port forward port 80 [default port] to the router that the DVR is connected to
- Create a DDNS account
- Enable DDNS in the DVR
- Enter the DDNS information into the DVR
- DVR must have access to the Internet or Local Area Network (LAN)
Installing CMS-DH

To install CMS-DH:

1. Locate the CMS-DH software included with the software CD.
2. Double-click the CMS-DH setup file.
   **NOTE:** You may receive installation warnings. This is normal. Accept the security warnings to continue.

3. Follow the on-screen instructions to install the software.

4. Click Yes to restart the computer when prompted.
Starting CMS-DH

To start CMS-DH:

- Double-click the CMS-DH icon ( ) on the desktop.

Adding a DVR from the local area network (LAN)

Once you open CMS-DH, you can add a DVR.

To add a DVR to CMS-DH:

1. Click **Device**.

2. Click **Scan** to locate connected DVRs on the network.

**NOTE:** By default, when adding a DVR from the LAN, the DVR name will automatically be named the last 3 digits of the IP address.
3. Click on the DVR you wish to add to CMS-DH, and then click **Apply→OK**.
   • The DVR appears on the left panel.

4. Click on the DVR you want to connect, and click the **Offline** button.

5. Double-click the name of the DVR to connect to the system.

**NOTE:** To add another DVR from the network, you must click the **Online** button to disconnect the DVR. Then repeat steps 1-5 to add the new DVR.
Adding a DVR using a DDNS address

If you have DVR systems that have DDNS set up, you can add them to CMS-DH.

Prerequisites

- Create a DDNS account.
- Enter the DDNS information into the DVR locally.
- Port forward the required port (default, port 80) to the router.

To add a DVR using a DDNS address:

1. Make sure the DVRs have been disconnected from CMS-DH. Click Device.

2. In the Device manager window, click Add.

3. Beside the Type drop-down menu, select DVR.
4. Enter the following into the blank fields:
   - **Name**: Enter the DVR name of your choice.
   - **IP/DDNS**: Enter the DVR’s DDNS address (for example tomsmith.digimerge.net)
   - **Port**: Enter the DVR’s port number (by default, port 80)
   - **User**: Enter the DVR’s user name (by default, admin)
   - **Password**: Enter the DVR’s password (by default, 000000)

5. Click **Apply** ➔ **Ok**.
6. Click the **Offline** button to connect to the DVR. Double-click the DVR icon to begin viewing.

1. Click the Offline button

2. Double-click DVR icon

**Final Result**

Once you have added the DVR, you can add multiple DVRs and view them in the tab. To switch DVR, click on the tabs near the top of the window.

Click the tab to switch DVR
Adding a Virtual DVR

A virtual DVR allows you to add video sources from multiple DVRs, into one main window.

Example

In the example below, multiple video sources from two DVRs are grouped into the Virtual DVR.

Prerequisites

- Ensure the DVRs are online, and connected to CMS-DH.

To add a Virtual DVR:

1. Click the **New VDVR** button [ ].
2. Double-click the virtual DVR icon in the tree menu on the left.

3. Click the + symbol to expand the DVR menu tree.

4. Drag the desired camera into the Virtual DVR window.  
   **NOTE:** You can drag the camera into any desired channel in the virtual DVR.
   
   **Example**

5. Repeat step 3-4 as required for different DVRs.
Creating New Group Folders & Sub folders

Creating group folders and sub-folders helps you organize multiple DVRs. For example, you can create a new folder for each different DVR.

**To create group folders:**
1. Right-click on the Group folder, then click **New Group**.

2. Drag the desired DVR into the new folder.

**To create a sub-group:**
- Right-click on the Group folder, then click **New sub group**.
Configuring General System Settings

To configure general system settings:

1. Open CMS-DH to access the Login window and then click **Setup** (Or, click **File > Setup** once you are logged in to CMS DH)

2. Configure the following in the Setup menu:
   - **OSD Setup**: Configure the on-screen display items that you want to appear in the channel (i.e. camera name, time, frame rate etc.).
   - **Password**: Change the CMS-DH login name and password. Enter your desired ID (user name) and password, and then click **OK** to save your settings.
   - **Miscellaneous**: Select the items you wish to enable:
     - **Check Watermark**: Checks the system screenshots to ensure that they have not been tampered.
     - **Keep Opened Window**: Automatically re-opens the windows that were closed after you restart the program.
     - **E-Map Link Event**: When selected, the E-map will open pop-up windows when an event occurs (setup required).
     - **De-interlace**: Enable De-interlace to reduce "feathering" effect of video playback.
     - **Sequence Time**: Enter the sequence time of each DVR.
     - **Alert Window Time**: Enter the amount of time the Alert window remains on screen.
     - **Video Standard**: Select from NTSC or PAL video output.
     - **Video Render**: Select the DirectX type of your system. Select VMR7 if your system uses Direct X 7.0. Select VMR9 if your system uses Direct X 9.0.
     - **Video Channel**: Select the maximum amount of DVR channels that the software displays. Choose Max 16 for 16 maximum channels, Max 64 for 64 maximum channels.
     - **Download Folder**: Select the download destination on your hard drive. The download folder stores saved videos and images. Click the browse button ( ) to select the default download directory.
Adding Users

You can add multiple users to CMS-DH, specifying the DVR menus that each user is allowed to access.

To add a new user:
1. Log in to CMS-DH.
2. Click File→CMS-DH Account.
3. Enter the following:
   - **ID**: Enter the desired user name.
   - **Password**: Enter the desired user password.
   - **Confirm Password**: Re-enter the user password.
4. Under the DVR list, click the checkbox to select the DVR the user will have access to.
5. Under 'Uses' click the checkbox to select the type of menus the user will have access to.
6. Click **Add** and then click **OK** to save your settings.

To remove a user:
1. Log in to CMS-DH as the administrator (default user name: admin, default password: 0)
2. Click File→CMS-DH Account.
3. Click the user name that you wish to remove.
4. Click the **Del** button to remove the user.
Recording Video to the hard drive

CMS-DH allows you to record video to your local hard drive. The amount of video that you can record depends on the size of your computer’s hard drive.

To record video:

1. During live view, click the **Rec** button ( ). The Rec button turns red.
   **NOTE:** If you want to capture a single channel of video, double-click the channel to view the channel in full screen mode, then click the **Rec** button.
   **NOTE:** If you want to capture all channels, ensure that you are viewing the DVR in split screen mode, and then click the **Rec** button.

2. Click the **Rec** button ( ) again to stop recording.
   **NOTE:** The file is saved into the default save directory of the CMS-DH software. To locate the save directory of the video files, click **File→Setup**, and look under Download Folder to determine where the file is saved.
Playing back recorded video

The video is saved as a proprietary file that is playable only by CMS-DH.

To play back previously recorded video files:

1. From the main window, click **File > File Playback**.

2. Click the **Open** button.

3. Select the desired file you wish to play and click **Open**.

4. Use the video playback controls to watch the video.
Remote Search
Remote search allows you to search for archived video on the DVR.

Prerequisite
- Ensure you are connected to the DVR that you wish to search from.

To search for video:
1. Right-click on the DVR that you wish to search video from, then click Remote Search.
2. To search for the video:
   a. Click $\Rightarrow$ to select the desired month.
   b. Select the date of the video.
   c. Select the hour.
   d. Select the minute.
3. Click the Play button to begin watching the video.
**Video Playback Controls**
Once the video begins to play, use the video controls to manipulate video playback.

**Local Search**
Local search allows you to search for video stored locally on the computer hard drive.

**Prerequisite**
Ensure you are connected to the DVR that you wish to search from.

**To search for videos stored on your hard drive:**
1. Right-click on the DVR that you wish to search video from, then click **Local Search**.
2. To search for the video:
   a. Click to select the desired month.
   b. Select the date of the video.
   c. Select the hour.
   d. Select the minute

3. Click the Play button to begin watching the video.

**Saving Video Files**

You can save the proprietary video files to your local hard drive from the Search menu. The video file ends in a .cms extension, and requires CMS-DH for playback.

To save video files from the search menu:

1. Select the month, date, and time of the video.

2. Click the Save As button.

3. Select the desired save directory, and click OK to save the file.
Converting video files to AVI

Converting proprietary CMS video files to AVI allows you to play the video on a computer that does not have the CMS-DH software.

Prerequisite
- Make sure that you are in the Local Search menu (Right-click on the DVR, and click Local Search)

To convert video files to .AVI:
1. Select the month, date, and time of the video.

2. Select the checkbox beside the camera you wish to back up video from.

3. Click the browse button ( ) and select the file output directory.

4. Click the AVI Convert button.
   - CMS-DH converts the file, and stores it in the output directory.
Schedule Recording

To enable/disable schedule recording:

1. Right-click on the DVR you wish to configure and then click Control→Schedule→Start / Stop
   - Click Start to enable schedule recording. Click Stop to stop schedule recording.

Schedule Backup to Local Hard Drive

You can schedule regular backup of video to your local hard drive. The schedule can be configured to back up 24 hours of video, or during a specified time only.

Prerequisite
- 3GB of hard drive space (backup will not function if there is less than 3GB)
- DVRs must be in offline mode

To configure Schedule Backup settings:
1. Click the DVR that you wish to configure.
2. Click the Device button (Device).
3. Select **On** to enable schedule backup.

4. Select **Daily** to back up 24 hours of video to your hard drive. Go to step 6.
   - Select **Hourly** to back up every hour of video to your hard drive. Go to step 5.

5. In the Minute drop-down menu, enter how many minutes the system should wait before recording. For example, if you enter 10 minutes, the system will backup video footage from 8:10 a.m to 9:10 a.m.

6. In the Hour drop-down menu, enter the time you wish to begin backup. For example, if you enter 5:00pm (05:00hr), the backup will start at 5:00pm, and end at 4:49am (the next day). Enter the hourly time in 24-hour format.

7. Select the channels that you wish to enable schedule backup.

8. Click **Apply** and then click **OK** to save your settings.
Configure Backup to FTP Server

You can schedule regular backup of video to an FTP server. The schedule can be configured to backup 24 hours of video, or during a specified time only.

**NOTE:** To schedule a backup interval other than 24 hours, follow the instructions below first to set up your FTP connection. Then, see “Backing up to an FTP Server” on page 59.

**Prerequisite**
Ensure you are connected to the DVR you wish to schedule backup for.

FTP server URL or IP address, user ID, and password.

**To configure backup to FTP:**
1. Right-click the DVR you wish to configure and click Setup.
2. Select System→FTP Backup.
3. Configure the following:
   - **Server**: Enter the URL or IP address for your FTP server on the left. Enter the port number on the right.
   - **Authentication**: Select On if the FTP server requires authentication. Otherwise, select Off.
   - **User ID**: If using authentication, enter the user ID for the FTP server.
   - **Password**: If using authentication, enter the password for the FTP server.
   - **Connection**: If your FTP server uses an Active connection, select Active. Otherwise, select Passive.
   - **Backup path**: Enter the backup directory on the FTP server.
   - **Channel**: Select the channels you would like to back up. Channels that are checked will be backed up; unchecked channels will not be backed up.
   - **Select**: Select All data to backup all recordings; select Event only to backup event recordings only.

**NOTE:** Do not include the ftp:// prefix.
4. Click **Start** to begin FTP connection.  
   **NOTE:** To confirm that the FTP connection has been made successfully, you must test the FTP connection using the local menus on the DVR. See “Backing up to an FTP Server” on page 59.

5. Click **OK→Apply**.  
The DVR begins FTP backup immediately. The DVR will backup data starting when the connection is established; it does not backup any data from the past 24 hours.

### Taking Screen Captures

You can capture screen shots as JPeg or Bitmap images (JPG or BMP).

**To take a screen capture:**

1. During live view, click **Capture**.  

2. Click the **Save As** button. Enter the desired picture name, and select the desired save directory, and then click **Save**.  
   **NOTE:** To take a screen capture of a full-screen, double-click the desired channel, then click the **Capture** button.
Viewing File Download Status

To check the download status of your video files:
1. Connect to the DVR you wish to check the video status on.
2. Click on **Tools > Download > Status**.
3. To cancel the download, click **Cancel**.

Changing viewing modes

To change the viewing modes of CMS-DH:
1. Log in to CMS-DH, and connect to a DVR.
2. Click ![Change Viewing Modes](image) to change the viewing mode (single-channel, quad-channel etc).
Sequencing

If you monitor multiple DVRs, you can have each tab change continuously. This process is called sequencing. You can perform sequencing as long as you have two or more DVRs. Virtual DVR’s work with sequencing as well.

Prerequisite

- Log in to two or more DVRs

To start a sequence:

- Click the **Sequence** button ( ).

**NOTE:** To change the sequence time, click **File→Setup**. Under "Miscellaneous", enter the desired sequence time in seconds, and click **Ok**.

![Sequence button](image)

The two DVR tabs will continually switch between each other
**E-Map**

The E-Map feature allows you to visually map your cameras over a Jpeg image.

**Example**

From the camera list, you can drag the camera icon over the Jpeg image.

**Prerequisite**
- Ensure the DVRs are online.

**To set up an E-Map:**

1. Click the **E-Map** button [E-Map].
2. Click **File→Background**. Locate the file you wish to import, and then click **Open**.

3. Drag the desired cameras from the camera list, over the image.
   **TIP:** You can also drag the DVR icon and E-MAP icon over the image.

   **Tip:**
   To rotate the camera, right-click on the camera, and click Rotate.
   Click the desired turning position to rotate the camera icon.

---

**E-Map Setup**

To configure the E-Map setup menu:
1. Click **File→E-Map Setup**.
2. Configure the following:
   - **Title**: Change the camera title.
   - **Show Description**: Show/hide camera name.
   - **Lock**: Locks the camera position.
   - **Description color**: Change e-map font color.
3. Click **Ok** to save your settings.
**Viewing video on E-Map**

Once you have mapped your cameras on E-Map, you can view, and search channels from the E-Map directly.

**To view live video on E-Map:**

- Double-click on the desired camera icon to open live view.

![Live channel](image)

**Configuring E-Map camera settings**

**To configure E-Map camera settings:**

1. Right-click on the camera you wish to configure.
2. Configure the following:
   - **Description Edit**: Edit the camera name on the E-Map.
   - **Remote Search**: Opens the video search menu.
   - **Live**: Opens a live view window of the camera.
   - **Property**: View DVR properties.
   - **Rotate**: Rotates the camera icon in the E-Map.

![Right-click menu](image)
**Zooming into the E-Map**

- To zoom into the E-Map, click the **Zoom In / Zoom Out** buttons.

**Removing camera icon in the E-Map**

- Select the camera icon in the e-map, and click the **Remove Item** button.

**Adding Multiple E-Maps**

To add multiple E-Maps:

- Right-click the Group folder, and click New E-Map.

To remove the E-Map:

- Right-click on the E-Map, and then click **Remove**.

Tip: After you have created a second E-Map, you can drag the E-Map icon over a Jpeg image in the E-Map.
Viewing DVR Health

To view the status of the DVR:
1. Select the DVR on the menu tree on the left.
2. Click the Health button (Heal).  

Closing windows

To close open tabs:
• Click the Close button, and select Close or Close All.

Locking Windows

• To prevent the tab from being dragged, click the Tab Unlock button.
DVR Log

The DVR log allows you to check events that occurred in the DVR, such as hard drive malfunction, video loss, motion detection, and alarm settings.

To access the DVR log:
1. Connect to the DVR that you wish to view the log from.
2. Right-click on the DVR, and click Log.
3. Configure the following:
   - **Begin & End**: Specify the start and end date and time.
   - **Query**: Select the event type you wish to search for.
4. Click **Search** to populate results.
   
   **NOTE**: Select the event and click the **Export** button to export the log as a text file. The log allows you to see any events logged by the DVR (i.e., motion loss etc.).
CMS-DH System Log

The CMS-DH log allows you to view video events that occurred in the system (i.e. motion and camera loss events).

**Prerequisite:**
- Ensure the DVR(s) are online and connected to CMS-DH

**To view the system log:**

1. Click the CMS-DH Log button (CMS-DH Log button).

2. Configure the following settings:
   - **Begin:** Enter the Month, Date, Year, and time you wish to begin to search the log.
   - **End:** Enter the Month, Date, Year, and time you wish the log search to stop.
   - **Channel:** Enter the channel number you wish to search.

3. Click the **Search** button.
   - A list of results populate. Double-click the event in the search results to begin event playback. Use the playback controls to control playback speed.
PTZ

To activate the PTZ control, click the PTZ button ( ).

**NOTE:** You must select the channel that has a PTZ camera before using PTZ controls.

---

**Setting PTZ Pre-Sets**

1. Click the Pan & Tilt buttons to move the camera to the desired position.

2. Click the **Save Preset** button ( ). Enter the desired pre-set number (between 0 - 9999) and then click **Ok**.

To access a pre-set

- Click the **Go to Preset** button ( ). Enter the pre-set number, and then click **Ok**.
System Setup

To access the full system setup menu:

1. Right-click on the DVR you wish to configure.

2. Click Setup from the sub-menu to access the full Setup menu.

**NOTE:** The menu structure is identical to the menu structure on the local DVR.
Upgrading the firmware remotely

Prerequisite

- Ensure the DVRs are online
- Download the firmware from www.digimerge.com, and extract the firmware file

To upgrade the DVR firmware using CMS-DH:
1. Right-click on the DVR that you wish to upgrade the firmware.
2. Click on Control→DVR Setup→Update.

3. Under Image File, click the browse button ( ). Locate the firmware file and then click Open.
NOTE: The firmware file ends in a .IMG extension.

4. Click Start to upgrade the system firmware. Wait for the system prompt before you close the window.
NOTE: Do not exit CMS-DH during the firmware upgrade process. Doing so may corrupt the DVR.
Configuring Post Event Action Tab

The Post Event Action tab allows your system to alert you when an alarm event triggers the DVR. For example, when the system detects motion from an input device, the computer speakers play a sound to alert you. Or, you can have the CMS-DH software alert you with a pop-up window when motion is detected.

Setting up Post Event Actions on a NO/NC Device

Prerequisites (If setting up NO/NC Devices)

• Connect the input device into the alarm block in the rear panel of the DVR.
• Ensure you have the correct settings for the device (N/O, N/C), and that you have correctly configured the settings in the DVR menu.
• Ensure the DVRs are online.

To configure the Post Event Action tab:

1. Expand the menu tree under the desired DVR that you wish to configure.
2. Under Alarm Input, right-click the number block that your device is connected into.
3. Click Post Event Action.
4. Configure the following:
   • Events: Select Alarm Input ON or Alarm Input OFF
   • Command: Select from Play Sound or None.
• Parameter: Select the desired alert sound you want the computer to play.

5. Click **Apply** and then **OK** to save your settings.
6. Under Alarm Output, right-click the light bulb icon, and click **Control**.
7. Click **Alarm Output On** or **Alarm Output Off**. This depends on your device type (N/O or N/C).
8. Click **Apply** and then **OK** to save your settings.

When an alarm is triggered, the system will play a sound on the computer.

### Configuring Alarm Output

**To configure the alarm output type:**

1. Under Alarm Output, right-click the light bulb icon, and click **Control**.
2. Click **Alarm output on** to enable the alarm out device, or **Alarm output off** to disable the alarm out device
Setting message pop-up notifications
You can configure CMS-DH to produce message pop-up windows when an event occurs.

To configure CMS-DH to produce message pop-up events:
1. Expand the menu tree under the desired DVR that you wish to configure.
2. Right-click on the camera you wish to set alerts for, and click Post Event Action.
3. In the Events drop-down menu, select the type of event that will trigger CMS-DH to produce a pop-up window when an event is detected.
4. In the Device drop-down menu, select the System.
5. Under the Sub Type drop-down menu, select Window. Under the Command drop-down menu, select Alert Window.
6. Click Apply and then click OK.
Result
When the camera detects motion, a pop-up window appears on the bottom-right corner of the screen to alert you.

Setting Video pop-up notifications
You can configure CMS-DH to produce video pop-up windows when an event occurs.

To configure CMS-DH to produce video pop-up events:
1. Expand the menu tree under the desired DVR that you wish to configure.
2. Right-click on the camera you wish to set alerts for, and click Post Event Action.
3. In the Events drop-down menu, select the type of event that will trigger CMS-DH to produce a pop-up window when an event is detected.

4. In the Device drop-down menu, select the name of your DVR.

5. Under the Sub Type drop-down menu, select Camera.

6. Under Sub No., select the channel number you wish to appear as a pop-up alert.

8. Click Apply and then click OK to save your settings.

**Result**
When the camera detects motion, a pop-up window appears with live video.
Configuring other Post Action Events

Under the Command drop-down menu, there are several commands that CMS-DH can output.

- GoTo PTZ: Opens the PTZ camera.
- Auto Tour: Opens the PTZ camera and starts the Auto Tour.
- Auto Pan: Opens the PTZ camera and starts the Auto Pan feature.
- Auto Tilt: Opens the PTZ camera and causes the PTZ camera to Auto Tilt.
- Live: Opens a live video window.
- Record: Begins live recording.

POS Data Search

The POS Data Search function is not available for the DH200+ series.
Running CMS-DH on multiple monitors

CMS-DH can support a maximum of 8 monitors on a single system. Running 8 monitors is extremely resource intensive. The recommended system specifications is listed below. If your system does not meet the requirements below, you may experience slow system performance.

Minimum system recommendations to run CMS-DH on multiple monitors
- Intel Core i5 or i7 processor
- 6 GB of RAM
- A motherboard that can support up to four (4) PCI-E video cards
- Geforce 9500 GT video card, 1GB or greater

To run CMS-DH on multiple monitors:
1. Connect to CMS-DH. Open the desired DVR’s / E-Maps etc. that you wish to view.
2. Drag the desired tabs to a different monitor.
3. Repeat as required.

Final Result
iSMS Client (Remote Viewing on the Mac)

The iSMS Client allows you to remotely connect and configure your DVR using the Safari browser in Mac OSX 10.6.

System Requirements

Your system must meet or exceed the requirements below before installing the iSMS Client:

- Operating System: Mac OSX 10.6 or later
- CPU: Intel Core Duo series CPU or higher
- Memory (RAM): 1024 GB
- Video Card memory: 256 MB
- Free Hard Drive space: 2GB
- Video Resolution: 1024 x 768

Prerequisites

- Download the iSMS client from www.digimerge.com, under the DH230’s product page
- Port 80 [or whichever port your system is using] must be port forwarded to your router
- You must create a DDNS account, and have the DDNS settings configured in your DVR
- The DVR must have internet access
- You must have a Digimerge DDNS address to log in remotely

Installation Steps

To install the iSMS Client:

1. Double-click on the iSMS Client icon.
2. Follow the on-screen instructions to install the software. Enter your password when prompted to install the software.
Using the iSMS Client

To open the iSMS client:
1. Locate the iSMS program in the Applications folder.
2. Double-click the iSMS icon to start the program. The iSMS login window opens.

To log in to your DVR remotely:
1. In the Host Port field, enter the DDNS address of your DVR in full, including the port number. (i.e. tomsmith.digimerge.net:80)
2. In the User Name field, enter admin.
3. In the Password field, enter your DVR password (by default, 000000)
4. Click Connect to log in to the system.

To change the save directory:
1. Click the directory name under “Backup”.
2. Select the desired save directory.
3. Click Open to apply your changes.

To delete an account:
1. Select the DDNS address beside the Host Port drop-down menu.
2. Click the Delete button to remove the account.

To view a previously saved video on the hard drive:
1. Click the File Open button.
2. Locate the directory of the video. Select the video and then click Open to begin video playback.

Note
The iSMS client supports a maximum of three (3) connected users.
iSMS Interface

The iSMS Interface displays all connected channels of your DVR.

1. **Channel Numbers**: Click the desired channel to view in full screen.
2. **Viewing Modes**: Click the icons to switch viewing modes (i.e., split screen, quad-view).
3. **PTZ Menu**: Opens the PTZ menu.
4. **Screen Capture**: Takes a picture of the main viewing window, and saves it to the hard drive to the save directory you specify.
5. **Hide Menu button**: Collapses the tool bar and hides the interface functions.
6. **Record**: Click to record video of the selected channel. Click again to stop recording. The file saves to the directory you specify.
To take a screen capture:

1. Click the Screen Capture button ( ).
2. Enter an image name into the blank field, and then click Save or click Print.

To record live video:

1. Click the Record button ( ). The record button turns red ( ).
2. Click the Record button again to stop the recording.

   NOTE: The video file saves into a folder to the save directory you specify.

To view recorded video:

1. In the tool bar, click DVR>File Play.

2. Locate the video file on your hard drive.
   • The video file ends in a .cms extension.

   A video save folder looks similar to the image above.

3. Click Open to view your saved file.
Using the iSMS Client

Configuring OSD Settings

The iSMS interface can be customized to show less or more information.

To configure the iSMS display settings:
1. From the tool bar, click iSMS>Preferences.
2. Select the display settings that you wish to remove by clicking the checkboxes.
3. Close the menu to save your settings.

Searching for video remotely

You can search for video from your DVR remotely, and back up the file to your local hard drive.

To search for video on your DVR remotely:
1. From the tool bar, click DVR>Remote Search.
2. From the Remote Search menu, perform the following:
   a. Select the Month/Year
   b. From the Calendar, select the date
   c. Select the Hour and Minute
   d. Select the channels you wish to search under by clicking the check boxes
Using the iSMS Client

5. Click the **Playback** button to begin viewing.

   OR

   Click the **Download** button to save the video to your default save directory.

**Download Progress bar**

During video download, the status bar indicates the progress of the saved video.
Using the iSMS Client

Playback Window

- Use the Playback Controls to manipulate video speed
  
  - Drag the video slider to skip through the video
  
  - Click the Rewind or Fast Forward buttons repeatedly to increase the speed
  
  - The Reverse Step and Forward step button advances the video by one frame
Searching for video locally

To search for local videos saved on your hard drive:
1. From the toolbar, click **DVR→Local Search**.

2. From the Remote Search menu, perform the following:
   a. Select the Month/Year.
   b. From the Calendar, select the date.
   c. Select the Hour and Minute.
   d. Select the channels you wish to search under by clicking the check boxes.

5. Click the **Playback** button to begin viewing. The Playback window opens.
Configuring PTZ settings

If your DVR has a PTZ (pan tilt zoom) camera installed, you can control the PTZ camera through the PTZ menu.

To open the PTZ menu:

- Click \( \text{\textbf{PTZ}} \) from the main interface.

PTZ Controls

To control your PTZ camera, click on the channel that your PTZ camera is connected to.
### PTZ Controls cont’d.

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Special Functions</td>
<td>Custom Functions depending on the PTZ Camera.</td>
</tr>
<tr>
<td>Auto Pan</td>
<td>Run Auto Pan.</td>
</tr>
<tr>
<td>Auto Tilt</td>
<td>Run Auto Tilt.</td>
</tr>
<tr>
<td>Pattern</td>
<td>Run Pattern.</td>
</tr>
<tr>
<td>Menu, Escape, and Pan Speed</td>
<td>Go into Menu.</td>
</tr>
<tr>
<td></td>
<td>Escape Menu.</td>
</tr>
<tr>
<td></td>
<td>Set Pan Speed.</td>
</tr>
<tr>
<td>Power</td>
<td>Power.</td>
</tr>
</tbody>
</table>
Configuring PTZ Protocols in the iSMS Client

You must enter the PTZ camera protocols and settings in the iSMS client before you can control the PTZ camera.

**To configure PTZ camera settings:**

1. From the toolbar, click **DVR>Setup**.

2. From the Setup window, click **Camera**.

3. Click the channel with the PTZ camera.

4. In the P/T/Z Model drop-down menu, select the PTZ protocol of your camera.
   
   **NOTE:** Consult your PTZ camera manual for protocol details.

5. In the P/T/Z ID field, enter the PTZ ID of your PTZ camera.

6. Click **Apply** to save your settings.
Configuring the iSMS Client

The iSMS client features a Setup menu that allows you to configure settings in your DVR remotely. The following menus are available for configuration:

- Display
- Camera
- Motion
- Record
- Alarm
- Schedule
- Network
- System

To open the Setup Menu:

- From the toolbar, click DVR>Setup.

- Click the appropriate Menu icons to configure the system.

**NOTE:** For details on configuring the DVR settings, consult the DH200 owner’s manual. The menus in the iSMS client are identical to the local DVR menu.
iPhone: Digi iMobile Touch App

Digi iMobile Touch is an app that allows you to remotely view your DH200/200+/230/250 series DVR on your iPhone. There are two versions of the Digi iMobile Touch app:

1. Digi iMobile Touch Lite (Free)
2. Digi iMobile Touch Pro (Payment required)

### Digi iMobile Touch Lite VS Digi iMobile Touch Pro

<table>
<thead>
<tr>
<th>Feature</th>
<th>Lite version</th>
<th>Pro version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Channels supported</td>
<td>16</td>
<td>16</td>
</tr>
<tr>
<td>Video Search feature</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Record On/Off control</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Schedule On/Off control</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Alarm On/Off control</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Number of DVRs Supported</td>
<td>2</td>
<td>10</td>
</tr>
<tr>
<td>Price</td>
<td>Free</td>
<td>$9.99 from the Apple App Store*</td>
</tr>
</tbody>
</table>

*Prices subject to change. Please check the Apple App Store for the latest pricing.

### Compatible Devices

- iPhone 3GS, iPhone 4, iPod Touch (3rd and 4th generation), iPad
- iOS 4.1 or later
- Digimerge DH200/200+/230/250 Series DVR
Prerequisites

- Port 80 (or whichever port your system is using) must be port forwarded to your router
- You must create a DDNS account, and have the DDNS settings configured in your DVR
- The DVR must have internet access
- You must have a Digimerge DDNS address to log in remotely
- An iTunes account

**NOTE:** You will need to create an iTunes account before you can download the app. An iTunes store account requires a valid credit card number. Your credit card number will be charged if you download Digi iMobile Touch PRO. The Digi iMobile Touch Lite app is free of charge.

Installation Steps

1. Search for **Digi iMobile Touch Lite** or **Digi iMobile Touch Pro** in the iTunes store. Follow the onscreen instructions to install the app.

**Digi iMobile Touch Lite**

**Digi iMobile Touch Pro**

Starting Digi iMobile Touch

- Tap on the Digi iMobile Touch Lite / Pro icon ( ) to start the app.
Configuring Digi iMobile Touch Lite/Pro

Once you have installed the application, enter your DVR’s information to connect remotely.

To enter your DVR information into Digi iMobile Touch Lite:
1. Tap the + button.

2. Enter the following:
   - **Name:** Enter the DVR name of your choice.
   - **IP/Host:**
     - Enter the local IP of the DVR, followed by a colon, followed by the DVR’s port number OR
     - Enter the DDNS address of the DVR, followed by a colon, followed by the DVR’s port number (i.e. touch.digimerge.net:80)
   - **Username:** Enter the DVR’s user name (by default, admin)
   - **Password:** Enter the DVR’s password (by default, 000000)

3. Tap **Done** to continue.

**Digi iMobile Touch Lite users:**
You can add a maximum of two (2) DVRs to the Device list.

**Digi iMobile Touch Pro users:**
You can add a maximum of ten (10) DVRs to the Device list.

You must include the port number when entering the DVR’s DDNS or LAN address.
Connecting to your DVR
1. From the Device List, tap the name of your DVR to connect.

Digi iMobile Touch Lite Interface

* Screenshots are stored in your iPhone’s photo album.
Digi iMobile Touch Pro Interface

About the Search and Control menus

The Search and Control menus are exclusive to Digi iMobile Touch Pro. The search menu allows you to search and playback video on your DVR.

The Control menu allows you to turn recording on or off, enable or disable relay control, and turn schedule recording on or off.

* Screenshots are stored in your iPhone’s photo album.
Changing Viewing Modes

- Touch 📷 📷 📷 📷 to change viewing modes.

Single channel view

Quad View

Swipe finger to change channels (single channel view only)

9-channel view

16-channel view

Digi iMobile Touch Lite interface shown

Rotating the Screen

Rotate your iPhone to change the image orientation.

Digi iMobile Touch Lite interface shown
**Toggling the On Screen Display (OSD)**

- Tap the **OSD** button to turn the OSD on/off. The OSD displays the recording status and DVR time.

**OSD Off**

**OSD on**

PTZ

To control connected PTZ cameras to the DVR:
1. Select the channel that the PTZ camera is connected to in single channel mode.
2. Tap the **PTZ** button.
3. Tap the arrows to pan/tilt the camera. Tap + and - to zoom in and out.

**PTZ button**

Digi iMobile Touch Lite interface shown
Digi iMobile Touch Pro features

Search
The Search menu allows you to search for recorded video on your DVR.

To search for video:

1. Tap the **Search** icon ( ).
2. Tap the arrows to select the month, and then tap the desired date to begin the search.
3. Tap the hour that you wish to begin the search. Next, drag the Min button to search for the minute that you wish to search.
4. Tap one of the preview windows to begin playback (see image above).
5. Use the playback controls to pause, fast forward, or rewind video.

Device Control
The Device Control menu allows you to turn recording, scheduled recording and relay alarms on or off.

To configure the Device menu:

1. Tap the Control button ( ).

2. Configure the following:
   - **Record**: Tap the Record button to turn DVR recording on or off.
   - **Schedule**: Tap the Schedule button to stop or start scheduled recording.
   - **Alarm**: Tap the Alarm button to turn alarm devices on or off.

3. Tap X to close the Device Control menu.
Digi iMobile Touch Lite is an Android app that allows you to remotely view your DH200/200+/230/250 series DVR.

**NOTE:** Digi iMobile Touch Lite is capable of **viewing only**.

**NOTE:** These instructions are based on the HTC Wildfire smartphone. For specific installation instructions, consult your smartphone’s user’s manual.

### Compatible Devices

- Android OS (2.1 and above, touch screen models only)
- Digimerge DH200/200+/230/250 Series DVR

### Prerequisites

- Port 80 (or whichever port your system is using) must be port forwarded to your router
- You must create a DDNS account, and have the DDNS settings configured in your DVR
- The DVR must have internet access
- You must have a **Digimerge DDNS** address to log in remotely
- An Android Market account

**NOTE:** You will need to create an Android Market account to download the app.

### Installation Steps

1. Search for **DigiIMobile Touch Lite** in the **Android Market**. Follow the on-screen instructions to install the app.

![Search for digiimobile touch lite](image)

### Starting Digi iMobile Touch Lite

- Tap on the Digi iMobile Touch Lite icon (📱) to start the app.
Configuring Digi iMobile Touch Lite

Once you have installed the application, enter your DVR’s information to connect remotely.

To enter your DVR information into Digi iMobile Touch Lite:
1. Press the Menu button on your phone, and then tap Add Device.

2. Enter the following:
   - **Name:** Enter the DVR name of your choice.
   - **IP/Host:**
     - Enter the local IP of the DVR, followed by a colon, followed by the DVR’s port number
     - OR
     - Enter the DDNS address of the DVR, followed by a colon, followed by the DVR’s port number (i.e. touch.digimerge.net:80)
   - **Username:** Enter the DVR’s user name (by default, admin)
   - **Password:** Enter the DVR’s password (by default, 000000)

3. Tap **Done** to continue.

*Phone interface may vary depending on model.*
Connecting to your DVR
1. From the Device List, tap the name of your DVR to connect.

To remove a DVR:
Press and hold the selected DVR, then tap Delete Device.

Digi iMobile Touch Lite Interface

Viewing modes
Double-tap the channel you wish to view on full screen
Take screenshot*
Toggle on screen display (OSD)

* Screenshots are stored in your phone’s photo album
Android: Digi iMobile Touch Lite App

Changing Viewing Modes

- Touch ▼ ▼ to change viewing modes.

Single channel view

Quad View

Tap the single channel button to change channels

9-channel view

16-channel view

Rotating the Screen

Rotate your phone to change the image orientation.
Toggling the On Screen Display (OSD)

- Tap the **OSD** button to turn the OSD on/off. The OSD displays the recording status and DVR time.

PTZ

To control connected PTZ cameras to the DVR:
1. Select the channel that the PTZ camera is connected to in single channel mode.
2. Tap the **PTZ** button.
3. Tap the arrows to pan/tilt the camera. Tap + and - to zoom in and out.
Installing the BDVRViewer App on your Blackberry

INSTALLING THE BDVRVIEWER APP ON YOUR BLACKBERRY

The BDVRViewer application allows you to remotely view your DVR on your Blackberry.

Prerequisites
- Blackberry 9000 or 9700 only
- An APN name, obtained from your Blackberry service provider (Digimerge does not provide this)
- A DDNS account from https://secure.digimerge.net/webapp/

Step 1 of 4: Download the BDVRViewer Application
1. Open the web browser on your Blackberry, and go to http://mobile.digi1.net/java/
2. Click on the BlackBerry Test Release link.
3. Click the Download button. Click Yes to any download warnings.
4. Click OK to exit.

You must port forward your router before you can connect to your system using a mobile device!
Step 2 of 4: Clear your browser cache
You must clear your browser cache for the BDVRViewer application to run properly.

1. Open the web browser on your Blackberry, and then press OPTIONS.
2. Click Options.
3. Beside Content Cache, click the Clear button.
4. Exit the web browser to save your changes.
**Step 3 of 4: Enable APN (Access Point Name)**

In order for BDVRViewer to function, you must enable APN (Access Point Name) on your Blackberry. Contact your service provider for your Blackberry’s APN name.

To enable APN:

1. Press the Menu button ( ).
2. Open the **Options** menu.

3. Select **Advanced Options → TCP/IP**

4. Select the checkbox beside **APN Settings** to enable APN.

**Example**

5. Beside APN, enter your APN address. **You must obtain the APN from your local service provider.**
6. Exit to save your settings.
**Step 4 of 4: Log in to BDVRViewer**

1. Press the Menu button ( ) and then open the Downloads folder.

2. Click on the **BDVRViewer** icon.

3. Enter the DVR DDNS address, port number, ID, and password, and then click **LOGIN**.

4. A network security window opens. Click **Yes** to connect to the DVR.

**Viewing Tips**

- During viewing, press the Menu button ( ) to open the channel options window. Select the desired channel to view in full screen, or select a group of 4 channels to view in quad mode.
## APPENDIX A: SYSTEM SPECIFICATIONS

### DH230 Specs

<table>
<thead>
<tr>
<th>Description</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Multiple Function</strong></td>
<td>Pentaplex</td>
</tr>
<tr>
<td><strong>Video Input</strong></td>
<td>4/8/16 x 1.0Vp-p, CVBS, 75ohms, BNC</td>
</tr>
<tr>
<td><strong>Video Output</strong></td>
<td>MAIN: 1 HDMI, 1 VGA, 1 Composite / SPOT: 1 (Programmable)/ Looping: 4/8/16</td>
</tr>
<tr>
<td><strong>Audio Input</strong></td>
<td>1 x line-in [RCA]</td>
</tr>
<tr>
<td><strong>Audio Output</strong></td>
<td>1 x line-out [RCA]</td>
</tr>
<tr>
<td><strong>Communication Port</strong></td>
<td>RS-422, Ethernet (10/100 Base-T), USB 2.0</td>
</tr>
<tr>
<td><strong>Power</strong></td>
<td>12V, 6A</td>
</tr>
<tr>
<td><strong>Compression</strong></td>
<td>H.264</td>
</tr>
<tr>
<td><strong>Data Size</strong></td>
<td>0.6–7 Mbps/ch @ 30fps</td>
</tr>
<tr>
<td><strong>Live Display Resolution</strong></td>
<td>720<em>480(NTSC) / 720</em>576(PAL)</td>
</tr>
<tr>
<td><strong>Live Display Speed</strong></td>
<td>Real Time</td>
</tr>
<tr>
<td><strong>Display Split Mode</strong></td>
<td>1,4,6,7,8,9,10,13,16</td>
</tr>
<tr>
<td><strong>Operating System</strong></td>
<td>Linux [embedded]</td>
</tr>
<tr>
<td><strong>Recording Resolution</strong></td>
<td>120 fps 720x480(NTSC), 100fps 720x576(PAL)</td>
</tr>
<tr>
<td></td>
<td>240fps 720x240(NTSC), 200fps 720x288(PAL)</td>
</tr>
<tr>
<td></td>
<td>480fps 360x240(NTSC), 200fps 260x288(PAL)</td>
</tr>
<tr>
<td></td>
<td>480fps @CIF, 240fps @ HD1 120fps @ D1</td>
</tr>
<tr>
<td><strong>Recording Mode</strong></td>
<td>Continuous, Alarm, Motion, Schedule, C+M</td>
</tr>
<tr>
<td><strong>Recording Quality</strong></td>
<td>Low, Middle, High, Super, Ultra</td>
</tr>
<tr>
<td><strong>Motion Detection</strong></td>
<td>Area: 8*8 selectable grids / Sensitivity: 20 Sensitivity levels</td>
</tr>
<tr>
<td><strong>Search Method</strong></td>
<td>SMART search, date &amp; time, event, log motion, area</td>
</tr>
<tr>
<td><strong>Playback of Backup Files</strong></td>
<td>Mini-Player [auto copy], CMS, AVI</td>
</tr>
<tr>
<td><strong>Playback Speed</strong></td>
<td>Multi Level [full frame reverse PB supported]</td>
</tr>
</tbody>
</table>
# DH230 Specs (cont’d.)

<table>
<thead>
<tr>
<th>Description</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Backup Storage Interface</td>
<td>2x USB 2.0, Network</td>
</tr>
<tr>
<td>External Backup Device</td>
<td>External HDD, DVD-RW, Flash Memory Stick</td>
</tr>
<tr>
<td>Storage HDD</td>
<td>Up to 2 Internal HDD (4ch, MAX 4TB) / Up to 3HDD (8/16ch w/o optical drive, MAX 6TB)</td>
</tr>
<tr>
<td>Optical Drive</td>
<td>Optional internal</td>
</tr>
<tr>
<td>Time Zone</td>
<td>Selectable</td>
</tr>
<tr>
<td>DST</td>
<td>Auto</td>
</tr>
<tr>
<td>Time Synchronization</td>
<td>Supported via NTP server</td>
</tr>
<tr>
<td>Network Interface</td>
<td>RJ45/Ethernet</td>
</tr>
<tr>
<td>Network Line</td>
<td>LAN, WAN, Internet</td>
</tr>
<tr>
<td>Network Transmission Speed</td>
<td>Max 480FPS</td>
</tr>
<tr>
<td>Pre-Alarm/Post-Alarm</td>
<td>5 seconds ~ 5 minutes, programmable per camera</td>
</tr>
<tr>
<td>DDNS</td>
<td>Digimerge DDNS</td>
</tr>
<tr>
<td>Event Routing</td>
<td>Source: Alarm, Motion, Video Loss, System Power Loss, HDD Failure, Fan Lock, Temp Action: Record, system buzzer, alarm relay spot, e-mail, PTZ event</td>
</tr>
<tr>
<td>Controls</td>
<td>Mouse, Optional IR remote, front panel keys</td>
</tr>
<tr>
<td>Firmware Upgrade</td>
<td>USB</td>
</tr>
<tr>
<td>Dimensions (WxDxH)</td>
<td>360x360x70mm/ 14.1 x 14.1 x 2.75”</td>
</tr>
<tr>
<td>Weight</td>
<td>2.4KG/5.3lbs without HDD</td>
</tr>
<tr>
<td>Power Consumption</td>
<td>50W</td>
</tr>
<tr>
<td>Operating Temp</td>
<td>0°C<del>40°C / 32°F</del>104°F</td>
</tr>
</tbody>
</table>

As our products are subject to continuous improvement, Digimerge Technology Inc. and its subsidiaries reserve the right to modify product design, specifications, and prices without notice and without incurring any obligation. E&OE
## DH250 Specs

<table>
<thead>
<tr>
<th>Description</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Multiple Function</strong></td>
<td>Pentaplex</td>
</tr>
<tr>
<td><strong>Video Input</strong></td>
<td>8/16 x 1.0Vp-p, CVBS, 75ohms, BNC</td>
</tr>
<tr>
<td><strong>Video Output</strong></td>
<td>Main: 1 HDMI, 1 VGA, 1 Composite Spot: 1(8), 3(16) Programmable Looping: 8/16</td>
</tr>
<tr>
<td><strong>Audio Input</strong></td>
<td>8/16 x line-in, DSUB</td>
</tr>
<tr>
<td><strong>Image Size</strong></td>
<td>4-19 Kbyte (720x480), 3-14 Kbyte (720x240) 2-10 Kbyte (360x240)</td>
</tr>
<tr>
<td><strong>Audio Output</strong></td>
<td>8/16 - 1(RCA)</td>
</tr>
<tr>
<td><strong>Communication Port</strong></td>
<td>RS-232C, RS-422, 2*Ethernet (Gigabit), USB 2.0</td>
</tr>
<tr>
<td><strong>Power</strong></td>
<td>100~240V, Universal Voltage</td>
</tr>
<tr>
<td><strong>Compression</strong></td>
<td>H.264</td>
</tr>
<tr>
<td><strong>Data Size</strong></td>
<td>0.19<del>0.3 Mbps/ch @30fps [CIF,Low</del>D1,Ultra]</td>
</tr>
<tr>
<td><strong>Live Display Resolution</strong></td>
<td>720<em>480(NTSC) / 720</em>576(PAL)</td>
</tr>
<tr>
<td><strong>Live Display Speed</strong></td>
<td>Real Time</td>
</tr>
<tr>
<td><strong>Display Split Mode</strong></td>
<td>1, 4, 6, 7, 8, 9, 10, 13, 16</td>
</tr>
<tr>
<td><strong>Operating System</strong></td>
<td>Linux (embedded)</td>
</tr>
<tr>
<td><strong>Recording Resolution</strong></td>
<td>480fps @ D1: 720x480 (NTSC), 400fps 720x576 (PAL)</td>
</tr>
<tr>
<td></td>
<td>480fps: 720x240 (NTSC), 400fps 720x288 (PAL)</td>
</tr>
<tr>
<td></td>
<td>480fps: 360x240 (NTSC), 400fps 260x288 (PAL)</td>
</tr>
<tr>
<td><strong>Recording Mode</strong></td>
<td>Continuous, Alarm, Motion, Schedule, C+M</td>
</tr>
<tr>
<td><strong>Recording Quality</strong></td>
<td>Low, Middle, High, Super, Ultra</td>
</tr>
<tr>
<td><strong>Motion Detection</strong></td>
<td>Area: 8*8 selectable grids / Sensitivity: 20 Sensitivity levels</td>
</tr>
<tr>
<td><strong>Search Method</strong></td>
<td>SMART search, date &amp; time, event, log motion, area</td>
</tr>
<tr>
<td><strong>Playback of Backup Files</strong></td>
<td>Mini-Player (auto copy), CMS, AVI</td>
</tr>
<tr>
<td><strong>Playback Speed</strong></td>
<td>Multi Level (full frame reverse PB supported)</td>
</tr>
</tbody>
</table>
### DH250 Specs (cont’d.)

<table>
<thead>
<tr>
<th>Description</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Backup Storage Interface</td>
<td>2 x USB 2.0, 2 xeSATA (SATA-II), 2-Gigabit Lan</td>
</tr>
<tr>
<td>External Backup Device</td>
<td>External HDD, DVD-RW, Flash Memory Stick</td>
</tr>
<tr>
<td>Storage HDD</td>
<td>4 x 500GB HDD (Max 6TB) w/o built-in DVD-RW, 100% duty cycle, 16 MB expanded cache</td>
</tr>
<tr>
<td>Optical Drive</td>
<td>Optional internal</td>
</tr>
<tr>
<td>Time Zone</td>
<td>Selectable</td>
</tr>
<tr>
<td>DST</td>
<td>Auto</td>
</tr>
<tr>
<td>Time Synchronization</td>
<td>Supported via NTP server</td>
</tr>
<tr>
<td>Network Interface</td>
<td>RJ45/Ethernet</td>
</tr>
<tr>
<td>Network Line</td>
<td>LAN, WAN, Internet</td>
</tr>
<tr>
<td>Network Transmission Speed</td>
<td>Max 480FPS</td>
</tr>
<tr>
<td>Pre-Alarm/Post-Alarm</td>
<td>5 seconds ~ 5 minutes, programmable per camera</td>
</tr>
<tr>
<td>DDNS</td>
<td>Digimerge DDNS</td>
</tr>
<tr>
<td>Event Routing</td>
<td>Source: Alarm, Motion, Video Loss, System Power Loss, HDD Failure, Fan Lock, Temp Action: Record, system buzzer, alarm relay spot, e-mail, PTZ event</td>
</tr>
<tr>
<td>Controls</td>
<td>Mouse, Optional IR remote, front panel keys</td>
</tr>
<tr>
<td>Firmware Upgrade</td>
<td>USB, Network</td>
</tr>
<tr>
<td>Dimensions [WxDxH]</td>
<td>430x 450 x 103mm / 16.9 x 17.7 x 4”</td>
</tr>
<tr>
<td>Weight</td>
<td>10kg / 22lbs without HDD</td>
</tr>
<tr>
<td>Power Consumption</td>
<td>65W</td>
</tr>
<tr>
<td>Operating Temp</td>
<td>0°C<del>40°C / 32°F</del>104°F</td>
</tr>
</tbody>
</table>

As our products are subject to continuous improvement, Digimerge Technology Inc. and its subsidiaries reserve the right to modify product design, specifications, and prices without notice and without incurring any obligation. E&OE
APPENDIX B: SETTING UP REMOTE VIEWING

Setting up the Remote Viewing Feature requires several steps. Networking skills are required to correctly configure the remote viewing functions.

**What Do I Need?**

- DVR System
- A PC with the installed CMS-DH software
- A router (not provided with the system) and High Speed Cable or DSL Internet Connectivity (for remote viewing outside your network)

---

**Network Setup / Remote Access Overview**

**To setup remote viewing:**

1. With the system powered off, connect the system to the router using an Ethernet cable.
2. Power the system on. You must connect the system to the router prior to turning on the system. This allows the system and router to communicate over the network.
3. Press and hold the Enter button on the front panel to find your system’s IP address.
4. Enable Port Forwarding on your router. Refer to the included Router Guide and Basics of Remote Video Access Guide for further assistance with your specific network setup and hardware.
5. Setup an account at [http://ddns.digimerge.net](http://ddns.digimerge.net)
How Do I Find My IP and MAC addresses?

The IP and MAC address of your system are necessary for DDNS setup. DDNS allows you to view and control your system from a remote location.

To find your IP and MAC address using the remote control:
- Press the INFO button.

To find your IP and MAC address using the mouse:
1. Open the MAIN MENU and select SYSTEM.
2. Under the INFO tab you will find your system’s IP address and MAC address.

Finding Your External IP Address

If you wish to find your external IP address, you can use a third-party website such as www.showmyip.com

Your external IP address can also be found within your Router settings. Refer to your router user guide for further details.
How Do I Enable Port Forwarding?

You need to enable port forwarding on your router to allow for external communications with your system for the following port:

- 80

Computers, DVRs, and other devices inside your network can only communicate directly with each other within the internal network. Computers and systems outside your network cannot directly communicate with these devices. When a system on the internal network needs to send or receive information from a system outside the network (i.e. from the Internet), the information is sent to the router.

**NETWORK EXAMPLE**

When a computer on the Internet needs to send data to your internal network, it sends this data to the external IP address of the Router. The Router then needs to decide where this data is to be sent to. This is where setting up Port Forwarding becomes important.

Port Forwarding tells the router which device on the internal network to send the data to. When you set up port forwarding on your Router, it takes the data from the external IP address:port number and sends that data to an internal IP address:port number (i.e. Router External IP 216.13.154.34 to DVR Internal IP 192.168.0.3:80).

APPENDIX C: DIGIMERGE AUTO PORT FORWARD WIZARD

The Digimerge Auto Port Forwarding Wizard is an exclusive software that easily automates router port forwarding. Before setting up a DDNS account, it is recommended to run the Auto Port Forwarding Wizard to port forward the required ports.

Installation

To install the Digimerge Auto Port Forwarding Wizard:

1. Insert the system’s software CD, and follow the instructions to launch the Digimerge Auto Port Forwarding Wizard software.
   - The installation window opens.
2. Click Next to continue.
3. Click the Change button to change the default installation directory (optional). Click the Next button to continue.
4. Select the users who can see the Auto Port Forwarding shortcut (Optional). Click the Next button to continue.
5. Click the **Next** button and then click **Finish** to complete the software installation.

6. Double-click the Digimerge Auto Port Forwarding shortcut from your desktop to start the program.

**Obtaining Your Router Model Number and Version**
On most routers, the model and version number can be found underneath the router, printed on a sticker.

**Example**

- WGR614 refers to the model number
- v9 refers to the version number
Appendix C: Digimerge Auto Port Forward Wizard

Configuration

You must have the following before you configure the software:
1. Your router’s model number and version number
2. Your router’s user name and password
3. Your Digimerge device’s IP address
4. Your Digimerge device’s port numbers that require port forwarding

Initial Startup: Select language
1. Click the Language drop-down menu and select a language (English, French, Spanish). Click the Start button to continue.

2. If software updates are available, click the Download Now button in the top-right corner.
   • Run the update file and install the latest version of the software.

Step 1: Populate the router database
The Auto Port Forwarding Wizard automatically populates a list of current routers, and detects the number of connected routers.
1. Click the Next button after the software detects your router configuration.

2. If more than one router is detected, you may need to contact your ISP (Internet Service Provider) to port forward.
   For details on configuring multiple routers, see “Configuring multiple routers” on page 145.
Appendix C: Digimerge Auto Port Forward Wizard

Step 2: Enter your router settings
1. Under the Router drop-down list, select the model of your router.
   OR
   • Click the Search button ( ) to enter the name of your router model.

   **NOTE:** Click the Auto Detect button ( ) if you have a Linksys or Netgear router (works with most Linksys or Netgear models).

2. Under Router IP, click the Detect Router IP button ( ).
   • The router’s IP populates in the blank field. Click OK to exit the prompt.

3. Under Username and Password, enter the router’s username and password.
   • Optional: Under HTTP Type (default http://) and HTTP Port (default, 80), you may have to change the values depending on your router model. Consult your router manual for details.

4. Under IP, enter the IP address of your Digimerge device.
   **NOTE:** The IP is usually found in the information window of your DVR.

5. Under Port, enter the DVR’s Web Port (by default, port 80).

6. Click Next to continue.
Step 3: Update the router settings

1. Click the **Update Router** button.
   - You will see your router window open. The Auto Port Forwarding Wizard automatically populates your router with the relevant information. This will take a few moments.

2. Close the update window when the update finishes.

Step 4: Test your connection

1. Click the **Test Your Connection** button.
   - Your system's default browser opens and connects to your **Digimerge device**.

   **NOTE:** Ensure that Internet Explorer is your system’s default internet browser.

   **NOTE:** A window opens that prompts you to enter in your **DVR's** user name and password (do not enter your DDNS log in information).

   **NOTE:** ActiveX warnings may appear. Accept all ActiveX installation warnings to connect to your system. For details.

Configuring multiple routers

Your network may have two or more connected routers. During the initial launch of the auto port forwarding wizard, the program scans the network to detect the number of connected routers.

To check for multiple routers:

1. Click the **Detect Multiple Routers** button.
   - A list of connected router populates in the window.
Appendix C: Digimerge Auto Port Forward Wizard

- The “Possible 1st Router” refers to the router directly connected to your system. This is the router that requires the port forward information.
- The “Possible 2nd Router” refers to the router immediate to the internet connection. This is the router that requires you to configure a DMZ host connection.

**Scenario A: Router/Modem combination + Router**
- You may have a router/modem combination, with a second router in your network.

**Scenario B: Multiple Routers**
- You may have two routers in your network.

In both scenarios, the router that is immediate to the internet connection (Router 2 in illustration) must act as a “bridge” to another router (Router 1 in illustration). The Auto Port Forwarding Wizard must connect to Router 1.

A proper DMZ configuration in Router 2 allows all incoming traffic going through Router 2 to automatically pass to Router 1. Router 2 acts as a “dummy” router and passes all the incoming data onto Router 1. Router 1 is the router that needs the port forwarding information.
Configuring a DMZ host connection

- Connect to "Router 1" on your network (referred to as "Possible 1st Router" in the Auto Port Forwarding Wizard). Obtain the IP address of Router 1. Usually this can be found in the "Status" section of your router menu. The IP should begin with "192.168...."This IP address is your DMZ IP.
- Enter the IP address obtained from Router 1 into the DMZ section of Router 2.
- Once you have configured Router 2 with a DMZ connection, run the Auto Port Forwarding Wizard to begin auto port forwarding to Router 1.
- Consult your router’s owner’s manual for details on configuring DMZ settings.

Locating your Router IP - The Status Page

The "Status Page" of a router normally includes the router’s vital information such as the IP address.

Example

DMZ stands for Demilitarized Zone. Enabling a DMZ IP on your router enables one of the routers to pass information onto the second router.
APPENDIX D: SETTING UP DDNS SERVICE

Digimerge offers a free DDNS service for use with your DVR. A DDNS account allows you to set up a web site address that points back to your local network. The following outlines how to set up your free DDNS account.

To setup your free Digimerge DDNS account:

1. In your browser, go to http://ddns.digimerge.net and click Create Account.
2. Complete the Account Information fields with your personal information. Complete the Warranty Information with your purchase details (optional).
3. Complete the System Information fields:
   - **Product License**: Select DH200 from the Product License drop down menu. Note that selecting the DH200 will work for the DH230/DH250 DVRs.
   - **Product Code - MAC Address**: Locate the MAC address of your (recorded while loading the System)
   - **URL Request**: Choose a URL for your DDNS connection (i.e. your name, your company or business name, or anything of your choice.)
4. Once the information has been entered, click Create New Account.
5. Your Account information will be sent to you at the email Address you used in Step 2.
You will need this information for remote access to your system. Record your information below:

Username: ________________________________

Domain name*: ________________________________

Password: ________________________________

* Only the first part of the Domain Name is required for setup on the system. For example, if the full domain name is tomsmith.digimerge.net, you only need to enter tomsmith on the system.
How Do I Enable DDNS On My System?

Once you have registered for free DDNS service, use the information in the confirmation email to configure DDNS settings on your system.

To enable DDNS on your system:
1. Open the MAIN MENU and click NETWORK.
2. Select the DDNS tab.
3. Under USE, select DIGIMERGE.
4. Under DOMAIN NAME, enter only the first portion of your DDNS domain from the confirmation email.
5. Under USER ID, enter your Digimerge DDNS user name.
6. Under PASSWORD, enter your Digimerge DDNS password.
   **NOTE:** Obtain your Digimerge DDNS user name and password from the confirmation email.
7. Beside UPDATE TEST, click START. You should receive a “SUCCESS” message. If there is an error, check your network connections; check that you have entered the correct domain name, user ID, and password.
8. Click ENTER to save your settings. Press CANCEL/ESC to close remaining windows.

With DDNS entered on your system, you can access your DVR from a remote location by using the CMS-DH remote software or by entering the Digimerge DDNS domain name in your browser.
APPENDIX E: SETTING UP MOBILE ACCESS

This guide shows you how to view video streams from your DVR remotely using your iPhone® or Blackberry®.

Before You Begin

You must complete these two steps before starting:

1. **Register your DVR with the Digimerge DDNS service.**
   See “Appendix D: Setting Up DDNS Service” on page 148.

2. **Enable DDNS on your DVR.**
   See “How Do I Enable DDNS On My System?” on page 150.

Registering your DVR for Mobile Access

Before you can log in to your DVR with a mobile device, you must create a mobile account.

**To create a mobile account:**

1. Go to [http://mobile.digi1.net/](http://mobile.digi1.net/) on your web browser and click **Register**.
Registering your DVR for Mobile Access Cont’d

2. The sign up screen opens. Enter your desired user ID and password and click **Register**.

   **NOTE:** Your password must be at least six characters long.

![Sign up screen. Enter in desired user ID and password.](image1)

3. The DVR registration window opens. Click **ADD DVR**.

![DVR management window. Click ADD DVR to add your DH200.](image2)
Registering your DVR for Mobile Access Cont’d

4. The EDIT DVR INFORMATION window opens.

5. Enter any desired DVR name (the default name is “DVR”). Enter your DDNS domain name.

   **NOTE:** You do not have to enter the entire DDNS address under DOMAIN NAME. For example, if your registered DDNS name is `myoffice.digimerge.net`, you would enter: `myoffice` in the DOMAIN NAME field.
Registering your DVR for Mobile Access Cont’d

6. Enter your DVR’s user name and password. Click the Apply button.

**NOTE:** If you change the password of the DVR, you must update your account with the latest password.

7. A new window opens that shows: DVR *(the name of your dvr)*, ADD DVR, LOG OUT, SIGN UP. **Click on DVR *(the name of your dvr)*.**

8. The DVR camera list opens. Click the desired camera to start viewing video feed.

9. Congratulations! Your DH200 is registered and ready for mobile access.

**Viewing Video from your Mobile Device**

Once you have completed the registration steps, enter http://mobile.digi1.net/ on your iPhone or Blackberry browser. Enter in your user name and password created in step 2 to log in.

Once you are logged in, select the DVR you wish to view, and click on the desired camera to begin viewing live video.

To view other cameras, click the Back button to view the list of connected cameras.
APPENDIX F: CONNECTING PTZ CAMERAS

You can connect RS-422/485 PTZ cameras (not included) to the PTZ Control Block on the rear panel of the system.

To install a PTZ Camera:

1. Connect the Transmit Cable to the RS-422/485 TX (+) port of the PTZ block on the rear panel.
2. Connect the Receive Cable to the RS-422/485 TX (-) port of the PTZ block on the rear panel.
3. Connect the video cable to a BNC port (usually channel 1).
4. Open the Main Menu and select CAMERA.
5. Beside PTZ, click the SETUP button. Select the model of your PTZ camera.
6. Enter the PTZ Camera’s BAUD RATE.
   **NOTE:** The PTZ camera settings depend on the type of PTZ camera. Please refer to the specific camera manual for your brand and model of PTZ camera.
7. If desired, enter the Preset numbers [PRESET No.] and Dwell Time.
8. Press the ENTER button to save your settings.
Appendix F: Connecting PTZ Cameras

Using a PTZ Camera

To control a PTZ camera:
1. With your PTZ connected to the system, view the active PTZ channel in full-screen.
2. Right-click to open the virtual remote, and click the PTZ button.
3. Use the virtual remote to control the PTZ.

To open the HELP menu:
1. Click the MENU button.

2. Click on the virtual remote to open the help menu.
The PTZ Help Menu contains the following:

<table>
<thead>
<tr>
<th>Button</th>
<th>Result/Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>ENTER button</td>
<td>- Press to open the PTZ Help Menu; press again to close the menu</td>
</tr>
<tr>
<td>ESC button</td>
<td>- Press to cancel all PTZ operation</td>
</tr>
</tbody>
</table>
### Appendix F: Connecting PTZ Cameras

<table>
<thead>
<tr>
<th>MENU button</th>
<th>- Press to open the PTZ Virtual Remote; press again to return to the Short-cut menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>Navigation buttons</td>
<td>- Press ▲▼ to tilt up/down &lt;br&gt; - Press ◀▶ to pan left/right</td>
</tr>
<tr>
<td>Increase/Decrease buttons</td>
<td>- Press + / - to zoom in and out</td>
</tr>
<tr>
<td><strong>Button</strong></td>
<td><strong>Result/Action</strong></td>
</tr>
<tr>
<td>![Button Image]</td>
<td>- Set PRESET position; Spot Out on the remote control &lt;br&gt; - Move PTZ to a desired location &lt;br&gt; - Press the preset button &lt;br&gt; - Illuminate Custom 1 &lt;br&gt; - Set the # for the Preset location &lt;br&gt; - Click ENTER to save and exit</td>
</tr>
<tr>
<td>![Button Image]</td>
<td>- Go to the preset position; INFO on the remote control &lt;br&gt; - Press the GO button &lt;br&gt; - Enter the desired Preset # and Click ENTER</td>
</tr>
</tbody>
</table>
Appendix F: Connecting PTZ Cameras

Setting Pre-Sets and Tour

To set a Pre-Set:
1. Move the PTZ camera to the desired position.
2. Press the Preset button (・).
   • Custom 1 will illuminate.
3. Set the number for the Preset location.
4. Click ENTER to save and exit.

To go to a Pre-set:
1. Click the GoTo button (・).
2. Enter the desired preset number and click ENTER.

- Start AUTO TOUR
- Press the Auto Tour button
- Press + and enter the range of preset and Click ENTER
- For example, Auto Tour button, +5 will start the tour of 1~5 presets of the PTZ camera

- PTZ custom function 1; Display on the remote control
- PTZ custom function 2; Zoom on the remote control
- PTZ custom function 3; PTZ on the remote control

- Speed has 8 increments—keep pressing the buttons to increase/decrease speed
## PTZ Compatibility List

<table>
<thead>
<tr>
<th>#</th>
<th>Model Name</th>
<th>3X</th>
<th>Speed</th>
<th>Preset</th>
<th>Go to</th>
<th>Tour</th>
<th>A. Pan</th>
<th>A. Tilt</th>
<th>Pat</th>
<th>Me</th>
<th>Esc/Enter</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>PELCO, D</td>
<td>o</td>
<td>o</td>
<td>o</td>
<td>o</td>
<td>o</td>
<td>o</td>
<td>o</td>
<td></td>
<td></td>
<td>o</td>
</tr>
<tr>
<td>2</td>
<td>RVT, EZ Protocol</td>
<td>o</td>
<td>o</td>
<td>o</td>
<td>o</td>
<td>o</td>
<td>o</td>
<td>o</td>
<td></td>
<td></td>
<td>o</td>
</tr>
<tr>
<td>3</td>
<td>PELCO, P</td>
<td>o</td>
<td>o</td>
<td>o</td>
<td>o</td>
<td>o</td>
<td>o</td>
<td>o</td>
<td></td>
<td></td>
<td>o</td>
</tr>
<tr>
<td>4</td>
<td>Hitron, Fastrax 2</td>
<td>o</td>
<td>o</td>
<td>o</td>
<td>o</td>
<td>o</td>
<td>o</td>
<td>o</td>
<td></td>
<td></td>
<td>o</td>
</tr>
<tr>
<td>5</td>
<td>Bosch, Auto Dome</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>MERIT LINLIN</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>APPROMEDIA</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>LG.MULTIXE CAM/DOME</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>BBV, PROTOCOL V2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
APPENDIX G: CONNECTING ADDITIONAL EXTERNAL MONITORS

Use the Video port (BNC) on the rear panel of the system to use the Monitor Out function. Monitor Out displays the exact on-screen display of the system.

Use the Spot port (BNC) to use the Spot Out function. Spot Out displays connected cameras on the system.

**NOTE:** A BNC-to-RCA adapter (not included) is required to connect a monitor with RCA inputs.

To use spot out functions:

1. With a spot monitor connected, press the **SPOT OUT** button on the remote control or Virtual Remote followed by the numeric button for the channel you wish to view (full-screen).
2. Press the **SPOT OUT** button twice to begin Auto Sequence (by default, Spot Out on the system is set to Auto Sequence).

When an alarm is triggered, Spot Out will display the triggered channel in full-screen.
75 OHM Switch (DH230 16-channel models only / DH250)

The 75 OHM switch on the back panel of the monitor allows the DVR to compensate for over or under exposed images when connecting monitors to the Loop Out monitor (CAMERA OUT port).

- When connecting monitors to the CAMERA OUT port, push the desired switches in the up or down position to set the voltage impedance.
You can enable motion detection and alarm control from the Main Menu. You can also connect additional motion sensor devices to the system (i.e. motion sensors, door/window sensors). Use a motion detector or sensor to send a signal to the system to begin camera viewing and recording on the matching camera channel (when enabled in the Menu).

To connect an external alarm sensor (ALARM INPUT) to the system:

1. Connect the Signal Cable to the desired port in the alarm block.
2. Connect the Ground cable to the Ground port (G) in the alarm block.
3. Open the MAIN MENU and select DEVICE→ALARM.
4. Select the corresponding alarm channel and select INPUT.
5. Select N.C. (Normally closed) or N.O. (normally open) depending on your alarm/sensor setup.
6. Press the ENTER button to save your settings.

*16-channel, DH230 model shown.
APPENDIX I: FULL CONNECTIVITY DIAGRAM

The following diagram outlines a general set of connections available with the DVR.

*Number of cameras varies by model.
†16-channel model shown.
The following diagram outlines a general set of connections available with the DVR.

* Number of cameras varies by model.
† 16-channel model shown.
APPENDIX J: REPLACING THE HARD DRIVE

The system comes with a pre-installed 3.5” SATA hard drive. The DH230 supports up to 3 internal hard drives (without the optical drive). The DH250 supports up to 4 internal hard drives (4x 500GB) (without optical drive). Each hard drive should be up to 2TB max. The system supports a maximum of 6TB of storage.

**NOTE:** Make sure that the system is OFF and the power cable has been disconnected before changing the hard drive.

**DH230: Removing the Hard Drive**

To remove the hard drive:

1. Power off the system, and unplug all wiring / cabling from the system.
2. Remove the four (4) short screws on the side panels of the housing and the five (5) short screws on the rear panel. Keep these sets of screws separate.

**ATTENTION:** Do not remove the two screws near the fan on the side of the housing.
Appendix J: Replacing the Hard Drive

3. Carefully slide the cover away from the front panel and lift away from the housing. **NOTE:** Make sure the cover is clear of all ports and connectors on the rear panel.

4. Disconnect the SATA data and power cable from the hard drive. To remove the SATA data cable, pinch the metal connector, and gently pull.

5. Remove the four (4) mounting screws. Keep these screws separate.
6. Remove the four (4) screws on the side of the hard drive housing. Repeat for the other side.

**DH230: Replacing the Hard Drive**

**To replace the hard disk:**

1. Place the new hard drive in the housing, and secure with the 4 silver screws.

2. Mount the housing with the hard drive into the DVR chassis. Secure with the four (4) hard drive chassis screws.
3. Connect the SATA power and data cables in the hard drive.

**DH230: Installing 2 hard drives**

You can install two hard drives on the hard drive housing. Simply mount the hard drive on the upper portion of the hard drive chassis using 4 screws (normally included with new hard drives).

**Connecting two hard drives**

Once the hard drive is mounted into the system, connect the two SATA power and data cable into the hard drives.
DH230: Installing 3 hard drives (8 & 16 channel only)

On the 8 & 16 channel models, you can install a maximum of three hard drives in the system if you remove the DVD/CD-RW drive. This is optional. Note that if you remove the optical drive, you will need to back up externally onto a USB device.

To remove the internal DVD/CD-RW drive:

1. Remove the SATA power and data cable from the CD/DVDRW drive.

2. Turn the unit over, and remove the three (3) screws that secure the CD/DVDRW drive. Place your hand underneath the DVD/CD-RW drive as you loosen the last screw to prevent the DVD/CD-RW drive from falling.

3. With your hand over the DVD/CD-RW drive, turn the system over.
Appendix J: Replacing the Hard Drive

4. Slide the DVD/CD-RW drive out the slot.

5. Align the screw holes on the hard drive to the 4 blue rubber grommets. Ensure the SATA power and data connectors on the hard drive faces away from the front panel.

6. From the bottom, screw the hard drive in place.
7. Connect the SATA data and power cable to the hard drive.

**Final Result**
DH250: Removing the Hard Drive

To remove the hard drive:

1. Power off the system, and unplug all wiring / cabling from the system.
2. Remove the four (2) short screws on the side panels of the housing and the five (5) short screws on the rear panel. Keep these sets of screws separate.

**ATTENTION:** Do not remove the two screws near the fan on the side of the housing.
3. Carefully slide the cover away from the front panel and lift away from the housing. 
   **NOTE:** Make sure the cover is clear of all ports and connectors on the rear panel.

4. Disconnect the SATA data and power cable from the hard drive. To remove the SATA data cable, pinch the metal connector, and gently pull.

5. Remove the four (4) mounting screws on the hard drive chassis. Keep these screws separate.
6. Remove the four (4) screws on the side of the hard drive housing. Repeat for the other side.

DH250: Replacing the Hard Drive

To replace the hard disk:
1. Place the new hard drive in the housing, and secure with the 4 silver screws.

2. Mount the housing with the hard drive into the DVR chassis. Secure with the four (4) hard drive chassis screws.
Appendix J: Replacing the Hard Drive

3. Connect the SATA power and data cables in the hard drive.

**DH250: Installing Multiple hard drives**

You can install up to four hard drives on the hard drive housing. Simply mount the hard drive on the lower portion of the hard drive chassis using 4 screws (normally included with new hard drives).

**NOTE:** To install the 4th hard drive, you must remove the optical drive bracket, and order a hard drive bracket for the DH250 from Digimerge Support. The hard drive bracket allows you to install a hard drive in place of the DVD-R drive.
Formatting the Hard Drive

**ATTENTION:** Formatting the HDD erases all data on the hard disk. *This step cannot be undone.* System settings will not be erased.

**To format the hard disk:**

1. Press the **MENU** button on the front panel of the system.
2. Click **DISK→RECORDING DISK**.
3. Beside the hard drive you wish to format, click the **REMOVE** button.
4. When the system prompts if you want to remove the disk, click **YES**.
5. Click the **DISK MANAGER** tab.
6. Select the hard drive you wish to format under DEVICE.
7. Beside ACTION, select **ASSIGN TO RECORD DISK**.
8. Click the **START** button. The system begins to format the hard drive.
APPENDIX K: USING LISTEN-IN AUDIO

Listen-in audio allows you to listen to, and record live audio on the system.

To enable listen-in audio:

1. Connect the audio cable (RCA) from an audio capable camera (not included) to the AUDIO IN port on the rear panel of the system.
2. Open the MAIN MENU and select DEVICE.
3. Beside AUDIO RECORD, select the channel number you want to assign the recording to. **NOTE:** The number of audio inputs varies by model.
4. Press the ENTER button to save your settings.
Playing AVI Files

If you selected for the converted file to open automatically, the file will open in your default media player. If not, click QUIT to close AVI Converter.

**ATTENTION**: An AVI media player such as VLC or DivX is required to playback AVI files. You can also installed the XviD, DivX, or ffdshow codecs to play the AVI files in Windows Media Player.

**To playback AVI files:**

1. On your PC, open the folder where you saved the AVI file. By default, converted files use the following naming convention:
   ```plaintext
   yyyy_mm_dd_hh_mm_ss_channel#_channel#_channel#_channel#.avi
   ```
2. Double-click the file to open in your default media player, or right-click to open the file with a AVI-compatible media player.
APPENDIX L: REMOTE VIEWING USING INTERNET EXPLORER

Along with the CMS-DH remote client software, you can also view your system remotely using Internet Explorer (version 7 or later recommended). Remote viewing through Internet Explorer allows for viewing from up to three simultaneous connections.

**NOTE:** Remote viewing is only compatible with Internet Explorer. Mozilla Firefox, Opera, Safari and other browsers are not supported.

**To view your system using Internet Explorer:**

1. Open Internet Explorer.
2. In the address bar, enter your system’s IP address or your Digimerge DDNS domain followed by :80 — for example, http://192.168.1.1:80 or http://tomsmith.digimerge.net:80

   **NOTE:** You MUST include http:// in order to access your system.

   **NOTE:** If you need help finding your system’s IP address, see “How Do I Find My IP and MAC addresses?” on page 139.

3. Login with the user name **admin**, and your default system password, **000000**.

4. Right-click on the ActiveX installation bar and click Install **ActiveX Control**. You will need to install ActiveX in order to access live viewing.
5. Click **Install** when the security warning appears. The page will refresh and live viewing will commence.

![Internet Explorer - Security Warning](image1)

Click Install

**Final Result**

![Final Result](image2)
APPENDIX M: DH230/250 SERIES TOUCH SCREEN MONITOR SETUP

The DH230/250 Series DVRs can be controlled with a touch screen monitor (not included). Touch screen monitors must be Windows 7® Touch compatible to work with the system.

**Step 1 of 3: Connect the Cables**

**AC Power Cord:** Provides power to the touch screen monitor.

**VGA/HDMI/DVI Cable:** Transmits video from the DVR to the touch screen monitor. Connect one type of cable only.

**USB Cable:** Enables the DVR to recognize touch gestures on the monitor.
Step 2 of 3: Power on the Monitor

Step 3 of 3: Test the Touch Screen Functions

Before you start:
1. Make sure your monitor is turned on.
2. Power on your DVR.
3. Wait for the DVR to boot into the main viewing mode.

Access Virtual Remote
• While in viewing or playback mode, press and hold anywhere on the screen to access the Virtual Remote. For details, see “Using the Virtual Remote” on page 16. Tap outside the Virtual Remote to exit.

Navigate Menus
• While navigating menus, tap to select a menu option.
• Tap **ENTER** to save your changes and **EXIT** to exit menus without saving changes.

Select Channels
• While in a split-screen display mode, double-tap an individual channel to view it in full-screen. Double-tap again to return to split-screen display mode.

Reposition Channels
You can reposition the channels on the display screen. This can be very useful when monitoring a live location(s).

1. Place the main display screen in either a quad display, or in a multi split-screen configuration.
   **NOTE:** Repositioning will not work if the main display screen is in full-screen single channel.
2. Press and hold inside the channel you would like to move. Drag your finger to the channel you wish to reassign it to and release.

Press and hold inside channel 3 and drag your finger to move channel 3 to the channel 1 position.

**NOTE:** If the Virtual Remote appears while doing this, you may ignore it. After repositioning the channel, press anywhere outside the Virtual Remote to exit.

Channels repositioned
Channel 3 is now in the channel 1 position.
TROUBLESHOOTING

When a malfunction occurs, it may not be serious and can be corrected easily. The following describes the most common problems and solutions. Please refer to the following before calling Digimerge Technical Support:

<table>
<thead>
<tr>
<th>Error</th>
<th>Possible Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>• DVR is not receiving power, or is not powering up</td>
<td>• Cable from power adapter is loose or unplugged</td>
<td>• Confirm that all cables are connected correctly</td>
</tr>
<tr>
<td></td>
<td>• Cables are connected, but DVR unit is not receiving sufficient power</td>
<td>• Confirm that the power adapter is securely connected to the back of the unit</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Confirm that the unit is powered on [LED indicators on the front should be ON]</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• If the unit is connected through a power bar or surge protector, try bypassing the bar and connecting the power directly to the wall outlet</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Confirm that there is power at the outlet:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Connecting the power cable to another outlet</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Test the outlet with another plugged device [such as an electric calculator or phone charger]</td>
</tr>
<tr>
<td>• Remote control is not detected by the system</td>
<td>• Batteries in the remote control are drained</td>
<td>• Install a fresh CR2025 battery in the remote control</td>
</tr>
<tr>
<td></td>
<td>• There are no batteries in the remote control</td>
<td></td>
</tr>
<tr>
<td>• Hard drive is not detected by the system</td>
<td>• Hard drive cables are loose or not properly connected</td>
<td>• Remove the housing and check that hard drive cables are firmly connected</td>
</tr>
<tr>
<td></td>
<td>• Hard drive has not been initialized [formatted] by the system</td>
<td>• For details, see “DH250: Removing the Hard Drive” on page 171.</td>
</tr>
<tr>
<td></td>
<td>• There is no hard drive in the system</td>
<td>• Open the housing and install a 3.5” SATA hard drive</td>
</tr>
<tr>
<td>Hard drive is full (0%) and the unit is no longer recording</td>
<td>• Repeat Record is not enabled</td>
<td>• From the Main Menu, select RECORD. Beside DISK OVERWRITE, select ON. Click ENTER to save your settings. This enables the system to continuously record by overwriting data once the hard drive is full</td>
</tr>
</tbody>
</table>
## Troubleshooting (cont’d.)

<table>
<thead>
<tr>
<th>Error</th>
<th>Possible Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mouse not detected by system</td>
<td>• Mouse cable is not firmly connected to the system</td>
<td>• Firmly connect the mouse cable to the PS/2 port on the side of the system; or connect a USB mouse to the top USB port on the rear panel of the system</td>
</tr>
<tr>
<td></td>
<td>• Mouse is not connected to the system</td>
<td>• Turn the system OFF (press Power button on the front panel). Firmly connect a USB mouse to a USB port. Press the Power button again to turn the system ON</td>
</tr>
<tr>
<td></td>
<td>• System needs to be reset</td>
<td></td>
</tr>
<tr>
<td>• There is no picture on selected channels / camera picture is not being displayed</td>
<td>• Camera cables are loose or have become disconnected</td>
<td>• Check the camera video cable and connections</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Disconnect and reconnect the cable at the DVR and at the Camera</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Try moving the camera to another channel or use another cable</td>
</tr>
<tr>
<td>• The image on the DVR appears, but does not have sound</td>
<td>• Audio cables are loose or have been disconnected</td>
<td>• Check the AUDIO connections to the DVR</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Audio channel is set to OFF in the system menu</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Open Main Menu &gt; DEVICE. Beside AUDIO RECORD, select the channel that you wish to assign audio recording to. Click ENTER to save your settings.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Audio is associated with the wrong video channel</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Audio is only available for channel 1—connect the audio capable camera to channel 1 to avoid confusion</td>
</tr>
<tr>
<td>• I can’t set the time on the DVR</td>
<td>• The system is recording</td>
<td>• Stop all recording on the system before attempting to set the time—resume recording immediately after setting the time</td>
</tr>
<tr>
<td>• My system does not seem to be recording</td>
<td>• Continuous recording may be disabled</td>
<td>• Press ( \leftarrow ) on the front panel, or ( \bullet ) on the remote control or Virtual Remote—<strong>ATTENTION:</strong> For security, it is highly recommended to keep continuous recording ON at all times</td>
</tr>
</tbody>
</table>
## Remote Connectivity Trouble Shooting

<table>
<thead>
<tr>
<th>Error</th>
<th>Possible Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>I cannot connect to the system using a DDNS URL</td>
<td>No internet connection, A DDNS account was not created, Incorrect DDNS URL, DDNS not enabled on the system</td>
<td>Ensure the DVR is connected to a high speed internet connection. Ensure that you have created a DDNS account. Ensure that you type the URL in full i.e: <a href="http://tomsmith.digimerge.net:80">http://tomsmith.digimerge.net:80</a>. Ensure there are no spelling errors in the URL. Include http:// and the port number of your system in the URL. Ensure DDNS is enabled on your system.</td>
</tr>
<tr>
<td>I receive an error when I try to log in to the system</td>
<td>Incorrect user name and password</td>
<td>The default user name is: admin The default password is: 000000 Ensure that caps lock is disabled. The password and user name are case sensitive.</td>
</tr>
</tbody>
</table>
Need Help?

Please make sure to visit our website www.digimerge.com to receive product updates and information.

3 Easy Ways To Contact Us

Online:
Product support is available 24/7 including product information, user manuals, quick start up guides and FAQ’s at www.digimerge.com

By Email:
Technical support (for technical/installation issues)
tech@digimerge.com

By Phone:
North America: 1-866-816-5919
Technical support (for technical/installation issues)
Mon-Fri 8.00 am to 8.00pm EST

We welcome your feedback at info@digimerge.com

For more information, visit www.digimerge.com
Digimerge Digital Video Recorder (DVR) – 5/3/1 Year Limited Hardware Warranty

Warranty: Subject to the exclusions, limitations and exceptions, Digimerge warrants to the initial end-user purchaser that this hardware product is free from manufacturing defects in material and workmanship under normal use for a period of three (3) years from the documented date of purchase. Digimerge warrants the security certified Seagate SV35 Series Hard Disc Drive (HDD) for a period of (5) years from the documented date of purchase.

DVR Warranty Details:
The three (3) year warranty period consists of:
- One (1) year over-the-counter replacement warranty covering parts and labor
- Two (2) additional years of repair depot warranty covering parts and labor with proof of RA issued by Digimerge tech support
- Note: Return Authorization number (RA) must be issued by Digimerge Technical Support to the Dealer prior to product replacement at the Distributor.

Exceptions to the above warranty are:
- DVR components including, but not limited to, moving parts, motors, fans, removable flash memory. These are warranted for a one (1) year period.
- Data loss – end users are recommended to back up the content of the hard drive on a regular basis.
- Data recovery, consequential damages, incidental damages and costs related to removal and installation of the hard drive are not covered under this warranty and are not part of the repair or exchange process.

Software & Consumables: All software, accompanying documentation and consumables (including but not limited to fuses and batteries) provided with or as part of the product are furnished AS IS, and are excluded from warranty coverage. Digimerge is not obligated to provide the end-user with a substitute product during the warranty period or at any time.

NOTE: Products are subject to continuous improvement. DIGIMERGE Technologies Inc. and its subsidiaries reserve the right to modify product design, specifications and prices, without notice and without incurring any obligation. Software and firmware are subject to updates from time to time.

For valid warranty claims made during the warranty period, upon proper proof of purchase (which is defined as a “valid form of a bill of sale or receipt from an authorized retailer or distributor showing the original date of purchase”), defective products will, at the sole discretion of Digimerge, be repaired or replaced with equal or better product in terms of hardware features without charge if all the conditions set forth in this warranty are met. Any products repaired or replaced within the warranty period, shall be warranted by Digimerge to the initial end-user purchaser for 90 days from the return shipment date, or the remainder of the warranty term, whichever is longer. Repairs are warranted for 90 days outside the original warranty period. Products and parts, at Digimerge’s sole discretion, may be replaced with new or refurbished items, and the products and parts replaced become the property of Digimerge. Product returned to Digimerge must be properly packaged in its original packaging (or packaging providing the product with protection equivalent to the original packaging) and sent, with the postage charges prepaid via a shipping method that provides for tracking of your package, to the address provided at the time the Return Authorization was requested. The customer is responsible for all shipping costs associated with the return of the defective products for warranty service to Digimerge warranty/repair depot facilities. Products will be returned to the end-user freight prepaid. Digimerge reserves the right to replace the original hard drive with an equivalent one.

Exclusions and Limitations: Any of the following will void this warranty:
1. Installation or use of the product other than strictly in accordance with the instructions contained in the product’s instruction manual;
2. If the product is subjected to operating conditions (including atmospheric, moisture and humidity conditions) outside of the acceptable conditions specified in the product’s instruction manual;
3. If the product is subjected to misuse (not adhering to instructions supplied with the product), negligence, modification (of hardware, firmware or software) or abuse;
4. If the product is subjected to electrical short circuits or transients, accident, fire, flood or Acts of God;
5. Adjustment, maintenance or repair of the product other than in accordance with Digimerge approved procedures; and
6. Use of replacement parts other than those specified by Digimerge.
7. If the products original identification (trademark, serial number, model number) markings have been removed, defaced or altered.
DIGIMERGE MAKES NO CLAIMS OR WARRANTIES OF ANY KIND WHATSOEVER REGARDING THE PRODUCT’S ABILITY OR EFFECTIVENESS IN PREVENTING OR REDUCING THE RISK OF, OR DAMAGES RESULTING FROM, LOSS OR THEFT OF PROPERTY OR PERSONAL INJURY. THIS LIMITED WARRANTY IS IN LIEU OF ALL OTHER WARRANTIES, EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, ANY IMPLIED WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR USE OR PURPOSE. REPAIR OR REPLACEMENT AS PROVIDED UNDER THIS LIMITED WARRANTY IS THE EXCLUSIVE REMEDY OF THE PURCHASER. DIGIMERGE SHALL IN NO EVENT BE LIABLE FOR ANY SPECIAL, INDIRECT, INCIDENTAL, PUNITIVE, OR CONSEQUENTIAL DAMAGES OF ANY KIND OR CHARACTER, INCLUDING, WITHOUT LIMITATION, PERSONAL INJURY, LOSS OF REVENUE OR PROFITS, FAILURE TO REALIZE SAVINGS OR OTHER BENEFITS, OR CLAIMS AGAINST THE PURCHASER BY ANY THIRD PERSON, EVEN IF DIGIMERGE HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

No claims or statements regarding the product, whether written or verbal, by salespeople, retailers, dealers or distributors, that are not contained in this limited warranty or in the owner's manual are authorized by Digimerge and do not modify or expand this warranty. Some countries, states, or provinces do not allow the exclusion or limitation of implied warranties or the limitation of incidental or consequential damages for certain products supplied to consumers or the limitation of liability for personal injury. To the extent that such restrictions on limitations apply to the products, the above limitations and exclusions may be limited in their application. In that case, when the implied warranties are not allowed to be excluded in their entirety, they will be limited to the duration of the applicable written warranty, and if damages may not be limited then the above limitations on damages apply, but only to the greatest extent permitted by local law.

**Warranty and Non-Warranty Service:**

Warranty service can be received by contacting your Digimerge dealer (during the warranty period). The dealer is required to first contact Digimerge Technical Support for assistance. In the event the problem cannot be resolved over the phone or via email, Digimerge will advise to return the product, at customer’s expense, for repair or replacement. Upon receipt of the defective product, Digimerge will send a repaired or replacement product at Digimerge’s expense to the customer. Dealer should send product to:

**In United States:**

Digimerge Returns  
Schenker Logistics  
2363 E. Perry Road  
Suite 171, Dock Door 44  
Plainfield, IN 46168

**In Canada:**

Digimerge Technologies Inc.,  
Attention: Repair Department,  
250 Royal Crest Court,  
Markham, Ontario, Canada,  
L3R 3S1

**Out of warranty service:** Please visit our web site (www.digimerge.com) for the name and location of the Digimerge authorized service centers.
IT’S ALL ON THE WEB!

Tout est sur le Web!
¡Todo está en la Web!

The Right Cameras
High Resolution Cameras 480 - 540 TV Lines

Looking for Installation?
Digimerge has the best network of professional installers across North America.

The Right DVRs
STANDALONE DVR
INTEGRATED DVR

VISIT / VISITEZ / VISITE
www.digimerge.com

© Digimerge Technology Inc.